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Chapter 1

Introduction

1.1 What is IconNMR?

Welcome to IconNMR, a comprehensive user interface, tailor made for all your
NMR laboratory management and control needs. IconNMR was designed to make
the execution of routine NMR experiments easy and straightforward. The steps
necessary to acquire, process, and plot a spectrum are reduced to inserting a new
sample, defining the data file name, the solvent, and the experiment. No other
knowledge about the instrument, the parameters, or the software is necessary.
Although running on top and under the control of the computer’s Linux/Windows
operating system and Bruker’s TOPSPIN program, providing the acquisition and
processing functions, IconNMR shields the user entirely from both. Accessing
TOPSPIN commands is only possible if permission has been granted by the labora-
tory manager. As such, IconNMR is particularly suited for open access spectrome-
ters with a large number of users.
1
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1.2 What’s new in IconNMR 5.2

IconNMR 5.2 is part of TopSpin 4.1 and contains the following new features:

• InsightMR Supported on F80

• InsightMR now possible with Dynamics Center and/or Mnova

• F80 CTC Automation Robot supported

• Use SampleTrack Experiment Orders without Barcode Hardware (Enable
SamTrack Interactive Mode & Easy Mode)

• SmartDrive allows much more flexible choice of possible experiments using
Experiment 'Portfolios'

• SampleCase MAS intrgration active

• NOAH and PSYCHE Experiments now shown automatically in 
'Preceding Expeiments' Window

• Automation Preceding Window can show any .pdf file in expno/procno directo-
ries via the <Right Click> Context Menu

• More "Space" in the User Manager - Scroll down for all options

• [Automatic] External Setup (ExtSet) Holder definition, to use Icon's position
suggest system to allocate a suitable sample position

• Window Display and sizes, full-screen settings now remembered on Windows
Workstations

• Latin-1 Names (non-ASCII special language characters) now functional for
Solvent names

Potential Incompatibility:

"Generate Spectrum PS/PDF file in data set for possible dispatch to Email recipi-
ent" now prevents deletion of pdf/png files automatically generated in data sets; 

Previously such files were always deleted

• TopSpin Bruker User (Keycloak) System supported

In TopSpin GxP versions, access to IconNMR Configuration is only available
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using user accounts authenticated by TopSpin’s Keycloak system. Users log-
ging into IconNMR Configuration must have the “Spectrometer Configuration”
right.

• User readable log entries created
In GxP and standard IconNMR setups log entries for particular sensitive
actions are now created. 

• IconWeb allows for setting of Night experiments even when Priority is disabled

• Accounting reports may show measurement times for individual experiments

1.3 Previous Version Update

Read on in this section to catch up with improvements in the IconNMR software
since your last spectrometer software upgrade.

1.3.1 What’s new in IconNMR 5.1

Improved Domain User Support

• Display users only from particular ActiveDirectory groups
See Options->Resource File Settings->Domain (Windows only)

New Security Features

• Enable/Disable Users - Use the Enable/Disable buttons in the User Manager

• Configuration option to block empty passwords 
See Options->General->Security

• "ICON-NMR User" also saved to data set audit trail processing file

• One click/Automatic logout complete Lock down
See Options->Resource File Settings-> Automation

• TopSpin's lock dataset AU program available as a setting under Umask User
Manager options

• User Files no longer created automatically on start-up (apart from the very first
user)

• Data set directory paths inherit the permission of their parents (Windows only)
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• Restrict Disk paths to sub directories of disk paths shown in user manager
See Options->Resource File Settings->Automation

• IconWeb Server TLS 1.3 support

Please note, a version specific knowledgebase containing minor patches and other
items is online and continuously updated. Direct Access is available when the
Instrument is on the net, or where IconNMR is running on an networked system
with Internet access.

Use the Help->About menu entry and use the link shown under “KnowledgeBase”
where available.
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SST - qPQ Performance Qualification Test

This new addition to the standard suite of System Suitability Tests (SST) is
designed to enable users to perform a process qualification test, specifically for
application to quantitative NMR (qNMR) analyses. The test utilises samples that
are available from Merck KGaA, Darmstadt, Germany (which operates as Milli-
poreSigma in the U.S.  and Canada), and consists of a binary mixture of two well-
known Certified Reference Materials (CRM). 

The samples are manufactured to current best practices and concentrations as well
as the calculated uncertainty values that are given on the sample certificates are
entered into the dialog screen together with sample lot number, sample position
number and shim program.  

The results of the test are added to standard test report. See the dedicated
AssureSST manual delivered with the TopSpin release.

AutoCalibrate (New - Requires Additional License)

AutoCalibrate calibrates the 1H p90 pulse length, temperature calibration and 3D
shims. 
The calibration is performed on a single optimized sample containing the molecule
sucrose in 90% / 10% H2O / D2O with DSS (2mM) as the chemical shift refer-
ence.
As well as those parameters listed above, AutoCalibrate also performs integral
integrity/concentration calibration, ensuring the entire system is running opti-
mally.See the dedicated AutoCalibrate manual delivered with the TopSpin release.

Features:

• Dedicated sample from Bruker to maintain instrument performance

• Fully automated, runs at off-peak hours with minimum inconvenience

See separate Manual inside TopSpin and accessible from IconNMR Help

SmartDriveNMR (Update - Requires Additional License)

• Structural information now optional

• 2Ds acquisition performed with NUS in a fail-safe way

PotencyMR (Update - Requires Additional License)

• Analyte's integral defined with methods
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• Peak snappings

• Structure Verification is optional

• Option to eject/reinsert the sample

User Manager Update Experiment List Tool 

• Easily discover and add new experiments contained within this TopSpin release 

• Search for experiments in the user's experiment list

General Automation

• Fourier Support

• Create partial .xml Configuration Export files which may be loaded only
replacing their partial content

• MAS III handling improved - Non rotating samples are skipped

• Domain Users are displayed much faster

• Preceding experiment "failed" experiment colours now configurable - see Fail
Safe/Error handling

• Reworking of Automation window, streamlining Analysis integration

• Run Multi-Receive Experiments as composite experiments

• Suggest which sample position to use next at login time

• Dedicated SampleCase automation driver

• Improved configuration user interface experience

• Show the sample temperature in the automation window status line 

• Spreadsheet Import using user friendly column names, taken from the spread-
sheet

• Assure-SST Water Suppression Test

• Allow $USER and $USERGROUP in archiving directory paths

• Variables are now allowed in data set paths ($DATE,%m, etc.)

• sti <holder> - Send any data set to Automation for measurement on any sample

• Allow [ ] in DataSet names



1.3 Previous Version Update 7
DONE

INDEX

INDEX

1.3.2 What’s new in IconNMR 5.0

SampleJet Individual Sample MatrixID Support

• Scan a barcoded nmr tube into Icon's experiment setup table or easy setup win-
dow and place your sample anywhere. SampleJet will find it, and Icon will add
the ID information to the data set ready for an ID based search for all your sam-
ples experiments*

•Spreadsheet/External setup supported

•SampleTrack/SampleJet supported

•Integrated in IconNMR's Web interface

Potency Determination by qNMR

Designed to streamline potency/purity determination with a rapid and flexibly
workflow from sample submission to report, Bruker's new qNMR SW tools are the
ideal solution for both experts and non-experts working in a pharmaceutical devel-
opment environment, where quality is a must.

The new workflow uses qNMR with an internal standard, which eliminates errors
introduced by inherent sample differences. Commence by selecting Internal Refer-
ence, under Analysis in the Experiment Table, in IconNMR. The Analysis pop up
window allows the user to choose an internal reference (R); introduce a new one
R+ or a new batch (B) for an existing reference B+. You may also submit multiple
samples (in duplicate, triplicate…) to obtain the average potency. To use this
option, right-click on the first qNMR experiment in the Experiment Table and
select Averaging / Copy settings to next or alternatively, select n experiments
(Select them with the Ctrl key clicked) then choose Averaging / Use selected
experiments. A default experiment P_PROTON is provided and highly recom-
mended for optimal results when determining potency by NMR.

User intervention is possible at any time during the workflow either in IconNMR,
TopSpin or CMC-assist (data visualization, analysis refinement and report. There
is no need for an extra license when working at the spectrometer. The new features
are accessible when FastLane NMR in IconNMR is activated. Select “FastLane”
under Configuration / CMC-Verification.

InsightMR™

Monitor your reactions easily with this dedicated single interface, harnessing the
full power of your Bruker NMR Instrument. Close down TopSpin and use the
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InsightMR shortcut on your Windows Desktop to launch the program. The short-
cut icon is automatically placed on your desktop upon installation of the software.
See the Quick Start guide, under the 'Help' menu of InsightMR, for details on how
to use the program. 

SmartDriveNMR

Depending on a verification analysis by the CMC-assist algorithm, further mea-
surements and interpretations may be triggered. Get the most out of your instru-
ment by allowing it to decide what to measure. The ideal combination of NMR
experiments for the verification task is identified and carried out. It is decided on-
the-fly if further experiments can improve significantly the verification confidence
while complying with the user's demands concerning allocatable spectrometer
time and confidence.

The relevant inputs are intuitive and NMR independent - only relating to the struc-
ture verification task Desired verification confidence, Maximum measurement
time, Molecular structure and Solvent

For more information consult your CMC documentation.

Easy setup updated

• See what experiments are available at a glance for even faster selection.

• Limit the number/type of experiments to those you want to run, irrespective of
'User Manager' experiment lists

Virtual Parameter Sets

• Make new/Tweak experiments for use inside IconNMR Automation based on
any TopSpin parameter set.

• Parameters may be modified or even inherited by other experiments. Alterna-
tive/multiple Acquisition AU programs/commands may be prescribed or alter-
native underlying parameter sets selected.

• Eliminate the need for multiple customized parameter sets (even across multi-
ple instruments), with only minor differences. 
See Configuration->Virtual Parameter Sets

General Automation

• Time controlled temperature handling on SampleCase sample changers

• Use system passwords to login to IconNMR's https site
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• Accounting reports may now be generated for users which are broken down
according to the different settings of a particular originator item

• Accounting report output now available in spreadsheet format

• Pausing a run can remove or leave the sample in the magnet

• Start times are copied/set automatically to/on follow up experiments

• Absence of the Priority User permission no longer disables the day/night exper-
iment switch

• Spreadsheet files with .xlsx/.xls/.csv extensions can be imported automatically
when copied to the external setup directory

• Experiment numbers and parameter modifications can now be taken from
spreadsheets

• Send notification/data Emails in HTML with Authentication/Encryption

• Easily define multiple data archiving directories

• Configure Automation to start without User Identification. See Configuration-
>Automation Window

• Periodic Experiments Tool now makes full use of IconNMR's 'Start Time' sys-
tem

Other New Features:

• Export/Import All/Individual configuration settings (including user settings,
composites etc.) with one xml file to other IconNMR installations. See the File
menu in Configuration

• Hidden Options from _iconnmrrc.txt are now fully accessible from the Options
Resource File Settings Tab

• Start and Stop the run via External Setup keywords START_RUN,
STOP_RUN, also available as command line options (Type iconnmr ? in Top-
Spin for all options)

*) This feature may require additional hardware/updates on your SampleJet.

1.3.3 What’s new in IconNMR 4.7

• Take initial Title from Parameter set. Set this in General Options to always have
the title initially taken from the parameter set.
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• Access to different Linux Themes directly from IconNMR. Change the appear-
ance of the program from the general options page. Note: Under Microsoft win-
dows theme control is available from the Desktop->Personalize menu.

iPad Support

Web IconNMR interface now updated to handle the iPad. Login to the Web Icon-
NMR Automation interface from your iPad and add an WebApp Icon to your
Home Screen for easy optimized access to all your NMR measurements.

CMC-Assist / Fast Lane Improvements

• Known Impurities may be added to the CMC-PROTON setup experiment defi-
nition for improved Analysis results. Click on the “IMP” button under “Struc-
ture/Processing”

• Access to the CMC-Assist viewer directly from IconNMR’s Preceding Experi-
ments window. Right click on the experiment or set the standard action to
CMC-Viewer in configuration.

• Access to CMC Fast lane Reports via IconNMR’s web interface and Preceding
Experiments.

1.3.4 What’s new in IconNMR 4.6
• Automation window reads spreadsheets in .xls/.xlsx format with support for

multiple workspaces.

• Solvents/Experiments names containing spaces are now allowed. 

• Individual columns in Automation window may be hidden/displayed as
required. Click right on any column to choose columns for display.

• Variables may be used as Originator Items and/or Title. The following variables
are available: $NAME, $EXPNO, $DISK, $SOLVENT $EXPERIMENT etc.

• Experiments may be submitted, cancelled with <Alt-s>, <Alt-c> etc. directly
from the Sample Holder Overview window.

• Atma selectnuc command is executed in background, saving experiment time.

• SampleXpress sample changer may now be controlled via Ethernet.

• A new IconNMR controlled 'isx' command is available inside TopSpin for
direct Sample Changer (BACS/SampleXpress/SampleJet) operation, indepen-
dently of IconNMR. This controls the sample changer exactly as IconNMR
would.
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• Updated and improved IconWeb look and feel.

Additional Advanced Automation Features

Assure-SST1 (System Suitability Test) 
This is now an integral part of IconNMR and includes acquisition and analysis of
NMR standards for 1H line shape, 1H sensitivity, 13C sensitivity, 19F sensitivity,
31P sensitivity, and temperature calibration. This software automatically:

•Validates the instrument performance for line shape and sensitivity

•Performs temperature calibration and adjustment

•Includes an automated ‘Stop’ criteria to prevent user standard acquisition
upon specification failure

•Generates a PDF report of all SST results. Tests are performed regularly at
user defined intervals, requiring no instrument interaction and without
interrupting Automation.

See the new Assure Manual from the IconNMR Help Menu for more details.

Assure-NMR - Raw Material Screening1 

Impurities and adulterants pose potential liability exposure when present in the
manufacturing of pharmaceutical APIs, drug products and chemical products.

Increased reliance on a global supply chain amplifies the need for QC screening of
materials prior to use in manufacturing processes and the final product. Effective
screening where unknown adulterants may occur requires both Compound Speci-
ficity and Non-Targeted Methods. Assure-NMR (Raw Material Screening) aug-
ments the Material Validation System and provides a fully automated solution for
finding both adulterated and impure samples before incorporation into a final prod-
ucts ever occurs.

In so doing Assure-NMR reduces liability exposure, production costs and produc-
tion delays. Combined with Assure-SST, this becomes a powerful and easy-to-use
solution for simultaneous targeted and non-targeted screening of Raw Materials
for Impurities and Adulterants.

See the new Assure Manual in this Release for more details.

Fast Lane NMRTM
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The addition Fast Lane NMR1– a member of the CMCTM Product family – now
provides the user with additional post processing information for 1D 1H spectra.
Fast Lane NMR delivers meaningful integration regions, multiplet interpretation,
consistency evaluation, signal assignments, and quantification results. Fast Lane
NMR can be activated via a check box within Iconnmr’s Master Switches. To ben-
efit fully from Fast Lane NMR the user needs to:

• Set a reference spectrum for quantification via the ERETIC dialog within Top-
spin’s integration mode and indicate this spectrum within Iconnmr’s Master
Switches. 

• Select the Experiment “CMC_PROTON” within Iconnmr’s Automation. 

• Add the .mol file to the dataset within Iconnmr’s Automation either via draw-
ing or browsing.

It seamlessly works with the CMC-assist – a newly designed Graphical User
Interface – which enables the user to view and edit the Fast Lane NMR results in a
very convenient way. Please note that Fast Lane NMR requires the same license as
CMC-assist.

For further information please contact 
nmr-support@bruker.com.

1.3.5 Incompatible Changes

Automatic Field update settings and Lock -noauto solvent settings are no longer
controlled by IconNMR. Make any changes in the new TopSpin edlock window.
For Avance III systems, the lock -noauto setting is no longer necessary when
TopSpin 3.1 is used.

1.  Requires additional License(s) contact your nearest Bruker office for more details
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1.4 Hardware/software requirements

Supported Computer and Operating Systems
See the TOPSPIN 4.0 release letter.

Spectrometer: 
See the TOPSPIN 4.0 release letter

Software:
IconNMR 5.1 runs together with TOPSPIN 4.0

Release Media:

IconNMR 5.1 is installed from the TOPSPIN 4.0 DVD. 
The software is also available Online from www.bruker.com.

This manual applies to IconNMR Version 5.1. IconNMR contains this manual as
on-line documentation accessible from the Help menu.

IconNMR, like many Bruker solutions, has grown throughout the years. Users who
are new to IconNMR should start by using the Automation Interface, even if a
Sample Changer is not available.

IconNMR 5.1 still provides, as a service to customers accustomed to older Icon-
NMR tools, Routine Spectroscopy, for multiple experiment execution with or
without a sample changer and the ToolBox interface for performing complicated
experiments efficiently. The ToolBox has a simplified NMR Biotools interface for
even easier access to the 3D capabilities of your Spectrometer. This interface is
also available via the TOPSPIN biotools command.

Users coming from previous versions of IconNMR are encouraged to use the
Automation Interface if they are not already familiar with it.



14 Introduction
DONE

INDEX

INDEX

1.5 Support

Minor Patches for fixing particular known problems are available online from
within IconNMR. A version specific knowledgebase is continuously updated.

Direct Access is available when the Instrument is on the net, or where IconNMR is
running on an networked system with Internet access. 

Use the Help->About menu entry and click on “KnowledgeBase” where available.
Browse into the available subdirectories for patches. A link will be visible for the
access point on fileshare-bbio.bruker.com.

Software support is available from your local Bruker office or via e-mail from the
following address:

nmr-support@bruker.com

The Bruker www server www.bruker.com may provide additional information such
as downloadable upgrades for your IconNMR installation.

1.6 Installation of IconNMR

Please proceed as described in the TOPSPIN 4.0 Installation Guide. IconNMR can
be separately selected as an installation item from the TOPSPIN installation dialog
window.

1.7 Starting IconNMR

1.7.1 TOPSPIN configuration

Before you can start IconNMR and begin your work, the laboratory manager must
have installed TOPSPIN 4.0 and IconNMR from the release media. In addition, the
cf TOPSPIN Spectrometer configuration command (see the TOPSPIN manual) must
have been executed successfully.

Notes on TOPSPINHOME:

When you install TOPSPIN from the distribution DVD on Linux systems, you may
either choose Standard Installation or User-Defined Installation. The standard
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directory is /opt (Linux) or “C:\Bruker\TOPSPIN” (Windows), the user-defined
installation allows you to specify any directory. In this manual the actual installa-
tion directory of TOPSPIN is ‚TOPSPINHOME‘. All program modules of TOPSPIN

as well as some utility programs such as the Service Tools are located in TOP-
SPINHOME/prog and its subdirectories. All parameter sets, pulse programs, AU
programs, etc. are located in TOPSPINHOME/exp and its subdirectories. The
spectrometer configuration files are located in TOPSPINHOME/conf and its subdi-
rectories. The plotter and printer configurations files are located in TOPSPIN-
HOME/plot and TOPSPINHOME/print/ and their subdirectories, respectively.

Select one of the following methods to start IconNMR.

• Starting IconNMR from TOPSPIN level
If TOPSPIN is active, enter the command icon or iconnmr in its command line,
or call it from the Acquisition menu under More inside TOPSPIN.

• (Autostart) Have Topspin start IconNMR Automatically
Use the autostart feature in TopSpin to start IconNMR automatically. Use
Manage->Commands->Setup Commands Executed at TopSpin Start.
Possible commands include:
iconnmr or icon- starts the main IconNMR window
icona - starts Automation
iconc - starts configuration
iconr - starts Routine Spectroscopy
toolbox and biotools are also available.

1.8 Configuration Options

The first time any user uses IconNMR a default user file will automatically be cre-
ated allowing full access to the program. The Laboratory Manager will need to cre-
ate userfiles for other users who will be using the program. All aspects of the
software may be configured via the Configuration button of the IconNMR main
window and is described in detail in that chapter of this manual.

System and user management comprises the following items:

• Defining the legal spectrometer users

• Defining the experiments a particular user may execute

• Defining a number of permissions for a user, e.g.
- whether changes to the parameters of an experiment are allowed
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- exit permission from Routine Spectroscopy/Automation mode to TOPSPIN

- to manually lock/shim a sample
- file name restrictions
- print restrictions

• Defining user specific information, such as e-mail address or a costing group
(via User Specific Originator Info in the User Manager)

• Defining the disk directories where acquired data are stored

• Defining new composite experiments, i.e. several experiments combined under
one name

• Configuring IconNMR’s Automation module and Default Shim file loader

• and much more...
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1.9 Locking it all down - Security Aspects

All of IconNMR configuration is conveniently stored in simple ascii files which
given the correct permissions may not be edited outside of program control.

On Linux Systems the files are stored with permissions such that tampering with
IconNMR configuration simply isn’t possible provided the user does not have the
NMR Administrator (super user) or root password.

On Windows Systems this is handled by setting up IconNMR for day to day users
running in an account where the user is not a member of the Local Windows Group
“NmrSuperUser” or Administrator. The user should only be a member of the group
“NmrUser”. In such a setup, modifications to IconNMR configuration will be
impossible. Access to data may also be easily restricted by using the “Umask” set-
ting in IconNMR’s User Manager.

By removal of the “Supervisor” Permission, many TopSpin features including
those involved in processing may also be disabled. Use of the command line in
TopSpin is also disabled. Control of the Instrument then runs through the control
of the Automation Software.
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1.10 Using the mouse or the keyboard

Additional keys active in Automation mode:

• On Windows systems IconNMR fully supports the System Mouse setting
“Automatically move mouse pointer to the default button in a dialog box”
This can greatly increase ease of use for frequent IconNMR users.

• In Automation mode scrolling up and down in the experiment display area may
be done with the Alt + z and Alt + x key combinations respectively.

• Use Alt + Tab in the Title window in Automation mode to select the next button/
entry. (Tab on its own is taken as being a normal Tab indent function)

• The Esc key may be used to break out of any recursive action, eg. a copy or
multiple experiment parameter edit.

• On Originator Item entries in automation where standard values are available,
typing the first letter of the required value will open the combo box at the
alphabetically sorted index closest to that character. When the entry is editable,
us the ‘Down’ arrow to open the combo box.

Using Function Keys:

• For Icon is to recognize Function Key input, create a resource file called
_iconnmrrc.txt in the home directory of the user who normally starts TopSpin
for IconNMR use. If you’re not sure what you’re home directory is, close Icon-
NMR and restart it with the command ‘icon info’ in TopSpin. Your home direc-
tory will be displayed in an additional window.

Here is an example of one such resource file which defines F1 for IconNMR use.
Put both of the following lines in your _iconnmrrc.txt file to be able to use the F1
key in your Title and Originator entries:

bind Entry <F1> {%W insert insert “This is F1”}

bind Text <F1> {%W insert insert “This is F1”}

1.11 Troubleshooting

What to do if IconNMR doesn’t start:
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1.11.1 Recreate the Configuration Files:

IconNMR uses regular Ascii files to store configuration information from session
to session. Should these files become corrupted the program may not be able to
start correctly. Try renaming the following directories/files so that IconNMR has
to create them again.

TOPSPINHOME/conf/instr/<Instrument Name>/inmrusers/

and

TOPSPINHOME/prog/curdir/<User Name>/.inmrconfig

1.11.2 De-activate Windows Domain Accounts

If your Workstation is part of a large Windows Domain, it may take IconNMR
quite some time to get the user information from the domain controller. Some
domain controllers handle thousands of users and waiting for an answer may take
several minutes. Icon uses this information to provide an up to date list of available
users in the user manager. If the domain controller is experiencing problems or
your network connection to the domain controller is impaired, this information
may never become available.

You may circumvent this check by removing the check from IconNMR->Configu-
ration->Options->Resource File Settings->Domain. Use the Search entry (bottom
left corner) in Configuration and search for: DOMAIN_USERS 

IconNMR will not show any domain accounts after this change has been made.
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1.11.3 Prevent IconNMR from attempting to change file permissions/
Avoid problems when saving in Configuration Window

To further improve the response times in very large domains, you may also prevent
IconNMR from attempting to change the permissions of files (Configuration/Data
Sets) after their creation. This change is also made in IconNMR->Configuration-
>Options->Resource File Settings. Use the Search entry (bottom left corner) in
Configuration and search for: CHANGE_FILE_PERMISSIONS

Configuration files and data directories will thereafter be saved with permissions
which may not be secure and the Umask setting in Configuration->User Manager
will not be taken into account. 

Set the permissions of files/directories in the TOPSPINHOME/conf/instr/<Instru-
ment>/inmrusers as you require. 

Should you still have problems get in touch with nmr-support@bruker.de

1.11.4 Other Useful features configurable via Options->Resource File Settings

The following is a list of other items which are now accessible from the configura-
tion window in Options->Resource File Settings. The full text of the line as it
would appear in the _iconnmrrc.txt file in optional mode is shown for complete-
ness. You can search for the capitalized names below in IconNMR’s configuration
window.

• set TOJDX_PROGRAM tojdx5
Default value “tojdx”, Optional setting “tojdx5”
This option allows the old style tojdx program (tojdx5, 1D only version) to be
used in IconNMR.

• set EXIT_PERMISSION_CHECK_FROM_AUTOMATION_WINDOW yes
Default value “no”, Optional Value “yes”
This option when set to yes prevents users without the User Manager exit per-
mission from closing the Automation window. Normally this check only occurs
when attempting to close IconNMR.

• set JUMP_TO_NEXT_SAMPLE yes
Default value “no”, Optional value “yes”
This option forces IconNMR Automation to only execute one experiment per
sample before jumping to the next sample (if any). If only one sample has been
submitted this implies that the sample would be inserted and removed (pro-
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vided the eject last sample flag is set). This mode may be interesting for repro-
ducibility studies.

• set SHOW_SAVED_DOMAIN_USERS yes
Default value “no” optional value “yes”
This may be used on Microsoft Windows systems, in cases where IconNMR
should show previously saved domain accounts without actually questioning
the domain controller.

• set DOMAIN_GROUPNAMES
These are the names of ActiveDirectory Groups which should appear sepa-
rately in the User Manager for Configuration in IconNMR. Multiple Group
Entries are separated by spaces. This may be used in conjunction with
DOMAIN_USERS to prevent all available users from being displayed in the
IconNMR User Manager. Set the (Use) DOMAIN_USERS setting to off to
only show the group users mentioned here.

• set EXPNO_START_VALUE 10
Default value set by IconNMR to the default Icon Expno increment value.
May be set to any integer value to force IconNMR to begin using experiment
numbers from a particular number onwards.

• set EXPNO_ADD_INCREMENT 1
When adding experiments in IconNMR Automation this may be used to change
the standard experiment number increment to some integer value other than 1.

• set ALLOW_ONLY_SUPERVISOR_RUN_START yes
Default value “no”, optional value “yes”
Use this to only allow a user with the Supervisor permission set to start the run.

• set ALLOW_EDIT_PARAMETERS_WHEN_NOT_SUPERVISOR yes
Default value “no”, optional value “yes”
Normally users without the Supervisor permission may not access the standard
parameter editing windows via the Parameters menu.

• set TOPSPIN_SCROLLTOCURDATA yes
Default value “no”, optional value “yes”
Here you may let TopSpin’s browser update itself in order to keep track of the
data sets which are chosen for viewing in IconNMR’s preceding experiment
list.

• set LOCAL_AUTOMATION_HELP {“My Help” “http://www. bruker.com”}
This may be set to show an additional menu entry in IconNMR.
For example the following line would cause Icon to create a menu entry in
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Automation with the name “My Help”. Clicking on it would cause a HTML
browser to open for the site http://www.bruker.com

• set AUTOMATION_TEST yes
Default value “no”, optional value “yes”
This will force all successfully completed experiments to be re-submitted when
no more submitted experiments are available in the queue. The data will be
overwritten. If any experiment fails it will no longer be repeated and its data
remain available.

• set ALTERNATIVE_STATUS_VARIABLES
Under Options->General->Title its possible to include some additional infor-
mation on the spectrum printout. The standard is “<ExperimentName> <Sol-
vent> <Disk> <User> <Autosampler Holder Position>”
Using this field however it is possible to use other variables, or order them as
you would like. Possible variables include $data(Experiment) $data(CurrSol-
vent) $data(CurrentHolderText), $data(UserName) $data(ExperimentParSet),
$data(AutoSetInstanceName), $data(DataSetName), $data(Barcode),
$data(CurrentHolder), $data(CurrentFullSolvent), $data(Time).
When using the _iconnmrrc.txt file enclose the list of variables to use in quotes.

1.11.5 TopSpin globals.prop file

When IconNMR is in use, this file also controls which commands are disabled
inside TopSpin for non-supervisor users. The file is in 

$HOME/.topspin1/prop/globals.prop

To enable or disable the commands available to users when operating in non-
supervisor mode, search for the DISABLE_CMDS_FOR_ICON line. Here all the
commands are listed which are disabled inside TopSpin when a non-supervisor
user is logged into IconNMR.

In restricted (non-supervisor) mode, the Topspin GUI flowbar is also disabled. To
enable some menus for non priviliedged users, please enter following line in glo-
bals.prop as described above:

DISABLED_UI2TABS_FOR_ICON = UI2_TAB_FILE , UI2_TAB_START, 
UI2_TAB_ACQUIRE, UI2_TAB_PROCESS, UI2_TAB_ANALYSE, 
UI2_TAB_PUBLISH, UI2_TAB_MANAGE
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The menus which remain active should be removed from the list.

Older versions of TopSpin had an entry here disabling tozip. This has since been
removed but as this file remains unchanged from version to version it may be nec-
essary to remove this entry to allow the zip function inside IconNMR to work for
non-supervisor users

1.11.6 Supervisor Mode on Linux Systems:

This functionality has been adapted to work correctly with the KDE and GNOME
window managers. Users will however in such cases still have access to the desk-
top. If access to the desktop is to be denied the Motif Window Manager (mwm)
should be used. This may be started by selecting the “Failsafe” Session setting
before login. Then start the mwm window manager by typing mwm& 

After this step start an additional terminal window with xterm& and start TOP-
SPIN from this new window. If mwm is not available on your system you may
install it from the openmotif rpm file found on the TOPSPIN DVD in the linux/
rpm directory. Usually this is done with the rpm -i filename command. Other win-
dow managers may also work correctly. On some systems it may be also necessary
to enter the following line in the users .Xresources file:

Mwm*keyboardFocusPolicy: pointer

This file usually resides in the home directory of the user who started TOPSPIN
After this change you will need to issue the command xrdb -load .Xresources and
restart mwm



24 Introduction
DONE

INDEX

INDEX



Chapter 2

The Main Desktop

2.1 Overview

After starting IconNMR using one of the procedures described in the Introduction
chapter of the manual, the IconNMR main desktop will appear, showing the icons
in Figure 2.1 as command buttons. The following sections present a short descrip-
tion of the assigned functions. Every function will be discussed in detail in the fol-
lowing chapters of this manual.

The main desktop may cover the entire monitor screen, shielding the user from the
other windows active on the workstation. The desktop has a window manager
frame, which may be removed via the Supervisor permission, making it is impossi-

Routine 
Spectroscopy

Automation Toolbox Configuration

Figure 2.1 Icons of the main desktop
23
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ble to move it aside and access other programs. Should this default setting be too
restrictive for a particular user, the laboratory manager can add a window manager
frame to the desktop by activating the Supervisor permission at IconNMR’s Con-
figuration->User Manager page.

2.1.1 Routine spectroscopy

IconNMR, like many Bruker solutions, has grown throughout the years. Users who
are new to IconNMR should start by using the Automation Interface (see below),
even if no Sample Changer hardware is available.

ICONNMR 5.1 still provides Routine spectroscopy, as a service to customers
accustomed to older IconNMR tools. Users coming from previous versions of
IconNMR are encouraged however to use the Automation Interface if they are not
already familiar with it.

Routine spectroscopy mode was designed to help the user perform standard exper-
iments (provided by Bruker or set up by the laboratory manager) by simply follow-
ing the steps:

- Insertion of the sample into the magnet (manually, no sample changer)
- Defining a file name
- Defining the solvent
- Defining the experiment
- Starting execution

If not configured differently by the laboratory manager, experiment execution con-
sists of data acquisition, processing and plotting.

Any experiment will generate an entry in a protocol file, which can be for user
accounting in the System Manager Accounting program.

2.1.2 Automation

This is the advanced extension of Routine Spectroscopy for spectrometers
equipped with/without a sample changer. It may be used in a manual mode without
a sample changer. It is easy to use, has direct access to locking shimming routines,
includes features for dealing with sample priority, and is open-access for multi-
user walk-up usage.
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2.1.3 Toolbox

The IconNMR Toolbox is a user-configurable graphical interface providing an
experiment oriented template setup which interfaces seamlessly with ICONNMR’s
Automation front-end. These templates may be re-used or exchanged depending
on the spectroscopic task at hand. All the features of ICONNMR’s Automation win-
dow remain active and fully accessible. With the Toolbox though, such things as
default parameter values, locking and shimming routines, acquisition and process-
ing commands may be set on an experiment dependent basis. Parameter values
may be inherited from or bequeathed to other experiments or set globally for all
experiments on a particular sample or all samples. See the online manual for more
information.

2.1.3.1 NMR Biotools

This is a simplified front end to the IconNMR Toolbox and after some initial
splash screens acquiring general information on the Protein/Protein Ligand to be
investigated, guides the user into an Application Specific tree of suitable experi-
ments together with their parameters for measurement under Automation control.
No previous experience of the Toolbox software is required. This simplified inter-
face is available through the biotools TOPSPIN command or the Spectrometer menu
inside Topspin.

2.1.4 Configuration

Here you may define experiments and user specific properties of the program
interface. The Configuration interface consists of a browser style interface with
many pages of configuration possibilities pertaining to the program. Use the
Search field in the lower left hand corner of the window - chances are you will find
what you are looking for quickly.

2.1.5 Help

The Help menu allows you to access this IconNMR manual on line.
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Chapter 3

Automation

3.1 Entering Automation mode

Enter Automation mode by clicking on the respective icon of the IconNMR main
desktop. You can also start Automation directly from TopSpin by typing icona. An
identification window will invite you to identify yourself. This behaviour can be
disabled if required. 

3.1.1 User identification

See “User identification” on page 141 for more details on identification require-
ments.

3.2 The Automation Setup Window layout

After successful user identification, the user interface similar to Figure 3.1 will
appear on the desktop showing an array of sample holders. The size of the array
will depend on what type of sample changer you have installed on your instrument
and may be configured on the Configuration “Master Switches” page of IconNMR
Configuration. The setup window shows all samples and their respective status in
the system, Available, Queued, Running, Completed or error. You’ll find control
27
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buttons to add/edit/delete experiments from the setup window experiment list, a
preceding experiment list giving information on what the instrument actually did
and various other control buttons.

The setup window is the Automation control center. It is the master scheduler for
the instrument. It consists of the following items:

• The window manager bar showing the directory where the automation
information is to be temporarily stored.
This is allocated afresh each time the Automation program is started. A direc-
tory is formed based on the time/date the program was started on and the user-
name of the operator who started the program. This directory is used for storing
data sets temporarily. The directory resides in TOPSPINHOME/prog/curdir/
changer/inmrchanger.

• The main menu bar with pull down menus for Automation operation.
Most of the commands in this menu may be accessed quickly using keyboard
accelerators. For example <Alt-f, c> closes the automation setup window. This
is the same as clicking with the mouse on the 
File->Close menubutton. The setup window is designed to be suitable for key-
board or mouse interactions at all times. That way you can speedily set up new
experiments without having to jump back and forth between keyboard and
mouse operation. See “Using the mouse or the keyboard” on page 17.

• The setup Icon-Bar.
These buttons are for quick access to basic automation features, e.g. Start/Stop
Automation, show the sample holder overview, show more detailed experiment
information etc.

• The experiment display area consisting of list of experiment entries
There are three tiers of information shown in the listbox. At the top are the sam-
ple holders, then come the experiments followed by any reference experiment
information. For example, in Figure 3.1, holder 1 is at the top of the hierarchy.
It has 2 experiments (shown by the type icon). These 2 experiments belong to
holder 1, the COSY experiment has a reference spectrum information line.
Double clicking on any holder row in the experiment table, folds it up or down
to reveal information already entered or entry boxes for addition of further
experiments. If IconNMR is being used in a barcode mode then the first column
number in the table is not related to the sample position.

• The experiment queue control buttons
The buttons in the center of the setup window always apply to selected entries
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in the experiment listbox area. Use them to submit experiments to the queue,
remove experiments from the queue, edit previously cancelled experiments,
delete experiments or for addition/copying of experiment information. Their
operation will be described in detail later.

• A Preceding Experiments pane with details of experiments performed

Here you’ll find detailed information on completed experiments no longer in the
queue. The most recently performed experiments will appear here. The various
stages of acquisition are shown; ATM (automatic tuning/matching), rotation, lock,
shim, acquisition and processing. Successfully completed stages are shown with a
tick whereas stages where any problems were encountered are marked in red with
an ‘x’. 
Features:

• Double clicking on an entry will open TopSpin or the Amix-Viewer (config-
urable) program in the respective data set. The viewer may be configured via

Figure 3.1 Automation Setup Window
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Options->Configuration->Automation Window, it may also be disabled where
this is desired.

• Individual Columns may be moved as required. The new positions and column
sizes are recorded for the next run.

• Double Clicking on a column heading border sets the column width to the
width of the largest text item in that column.

• Most columns may be sorted by clicking once on the column header.

Right clicking on an entry opens a menu with further options.

Note:

More detailed information on what the Instrument actually did may be attained by
using the TOPSPIN history feature. Type hist in TopSpin to see a time stamped list
of all actions performed. Files containing all automation commands are then stored
in TOPSPINHOME/prog/curdir/<user who started Topspin>/history. The previous
TopSpin history information is stored in the file history.old.

Search Preceding
It is also possible to search through all experiments previously performed by 
IconNMR for a particular text. Text may be quoted in inverted commas to search
for an exact string, or if it is not quoted, the program will search for an entry con-
taining all of the given text items. Data set names, experiment names and title/orig-
inator information may all be searched.
This feature may be disabled via the Configuration->Automation Window->Dis-
play->Enable Search Preceding

Once you’ve come to grips with the overall layout of the setup window the next
step is to actually perform some experiments.

3.3 Automation Quick Start Guide

Here you’ll find all you need to know to get the automation up and running a.s.a.p.

3.3.1 First steps in IconNMR Automation

As is the case for Routine Spectroscopy Mode the TOPSPIN software must be
installed and configured correctly before commencing automation. See “TOPSPIN

configuration” on page 13 for more details and use the integrated “Setup Manual”
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accessible from the Help Menu.

To get your first automation run underway proceed as follows:

1. Start IconNMR from the Acquire->Options->IconNMR pull down in TOPSPIN.

2. Click on the Automation Icon.

3. Identify yourself to the system. If you do not see your user id in the identify
user window, you or the laboratory manager should save a user file using the
User Manager from the Options->Configuration Menu. See “User Manager”
on page 89 for more details.

4. Once you’ve successfully logged in, the Automation setup window appears
containing the appropriate number of sample holders. If you see the incorrect
number of holders in the setup window in the Holders column then set the num-
ber of default holders using the Configuration Manager->Automation Window-
>Display->Default Number of Sample Holders. This will be especially neces-
sary in Manual, NMR Case, Sixpack and MAS automation modes.
See page 118 for more details.

5. Choose the particular autosampler location you’re interested in and

a) Double click with the left mouse button on the holder or

b) Click on the holder and use the Add button <Alt - a>.

6. Once you’ve set the experiment details, use the Submit button to indicate that it
may be measured.
When an experiment is in the submitted state you may not make any modifica-
tions to it. Should you wish to change something then you should first Cancel
the experiment, then Edit.

7. You may add further experiments on the sample with the Add button as
required.

8. Click on the Start “cogwheel” icon to start the run. The program may also be
configured to start the run automatically. .
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3.4 Component Descriptions

3.4.1 The experiment entries

Each sample holder line in the setup window consists columns of information clas-
sified as follows:

1. Holder
A little triangular symbol and number/text indicate the current holder. The tri-
angle shows whether individual experiments for the holder position are being
displayed or not.

2. Matrix ID/Tube ID
Here you’ll find the barcode id of the sample to be measured. This may only be
used on systems providing barcode support.

3. Type
Shows whether a holder line has any information and if so displays the number
of experiments defined for that holder. An empty tube icon depicts an empty
holder. To add an experiment to an empty holder either double click on it, hit
Return on the selected entry or use the Add button.

4. Status
This may be configured to show traffic lights in two different modes or text.
The mode can be changed by using the Configuration user interface. See “Con-
figuration Options” on page 87. The following experiment states are currently
supported:

•Inactive

•Submitted to Queue

•Running

•Completed

•Error

5. Disk
Directory where experiment is to be stored. User selectable or definable form
the User Manager See “The Data Directories box” on page 99. The system
may thus be configured to allocate the disk partition automatically. This column
may be hidden or made read-only if the disk information is always the same
and thus irrelevant.



3.4 Component Descriptions 33
DONE

INDEX

INDEX

6. Name
Name of experiment. This may be entered by the operator or defined to be set
automatically from the User Manager. See “The Data Set Names box” on
page 96. The system may thus be configured to allocate the name automati-
cally.

7. No.
Experiment number to be used for this entry. This will automatically be allo-
cated to the next free experiment number based on the current user and the disk
and name the user has chosen. If the operator has the Data Set Edit permission
the experiment number may be freely chosen.

8. Solvent
The solvent may be set up here as defined at TOPSPIN configuration time by the
edsolv command. Changing the solvent for any component experiment of a
holder changes all other solvents for non-submitted experiments automatically.

9. Experiment
Here the operator may choose the experiment from his pre-defined list. This list
is defined with the User Manager. See “The Experiment List box” on page 90.
The experiment type, name and comment are given here. There are presently
two types of experiment normal (single) N or n and composite C or c. Lower
case characters imply that the experiment will be forced to run in the low prior-
ity “night-time” mode. If a composite experiment is chosen then new experi-
ment entries will be added as required for all components of the composite
experiment. 

10.Analysis Type
In this column decide if extra Analysis features beyond IconNMR are to be
used. Use the Analysis/Quantification button at the top of the Automation win-
dow to show this column.

11.Analysis / Quantification
When this feature has been enabled using the button at the top of the Automa-
tion window, a Mol/SD file may be set which will be used on HSQC experi-
ments to perform an automated structure consistency check. THE
SmartDriveNMR, PotencyMR and AssureNMR products receive additional
Analysis information here.

12.Method
This column is only available if the program has been configured to run in
BEST mode. Depending on the chosen solvent the corresponding methods as
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defined in bestadm Methods will appear in the pulldown menu. This informa-
tion used not be sample dependent, but now that the BEST utility has the capa-
bility of changing solvents the introduction of a solvent specific method, makes
the system even more flexible.

13.Priority
Users who have this option enabled in their user permissions file may decide to
prioritize particular experiments. Such experiments will then be run before non-
prioritized experiments. The priority is based on the time of their submission.
Such experiments will either be run after the current experiment is completed
or when all experiments scheduled on the current holder have been completed.
For more details see ’Priority Options’ on page 128. IconNMR also has a Day/
Night mode which may be used to ensure that time consuming experiments are
always run at night. Click on the Sun icon and it will toggle to a moon icon, this
will classify the experiment as lower (night-time) priority.
Note the day/night mode applies to individual experiments. If you want the
sample to be measured at night you must mark all its experiments as being
“night” experiments. If a user does not possess the “Priority” permission it is
still possible for that user to set a “Day” experiment to “Night”

14.Par
This column currently consists of 3 buttons controlling the User Specific
Parameters, the Lock/Shim/ATM settings and printing for individual experi-
ments.
User Specific parameters may be accessed directly from this column, provided
they have been defined for the respective user, see Figure 5.2.1.11. Changes in
this window will be copied to all subsequently copied entries. If the Modify
Lock/Shim/ATM permission has been set in the User Manager, then the current
settings for Lock, Shim as well as the experiment dependent ATM mode may
be altered as necessary.
The Lock options is treated on a holder basis and not on an experiment basis.
The Shim option may be set up such that it is possible to shim on every experi-
ment. For this option set the “Shim the sample” option in the configuration win-
dow’s Shimming Controls page to “on every experiment”. 
Using the Print toggle switch, you can control whether a print out will be gener-
ated or not for each experiment. A green ‘Tree’ icon is shown if no print out is
required, otherwise a printer icon is displayed. The User Manager also contains
two permission settings for controlling this feature. Printouts may be disabled
for individual users and users ability to control the generation of printouts may
also be suppressed.
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15.Title
The title icon when activated pops up a text entry box which may be used to
enter a specific title for later plotting. Originator information items (if acti-
vated) are also to be entered here. See “The Originator Items Editor” on
page 104. The title information will automatically be copied to all other experi-
ments added on a particular sample. The title icon changes after text has been
entered. Use the ‘Set & Copy Title’ button to force all other title entries (those
on-edit for the current sample) to set their entries to the same values as the cur-
rent title box.

16.Start Time
This field shows the approximate time at which the experiment will commence.
When an experiment entry is on edit it will show a timebox where an experi-
ment start time may be set. This feature is only available for users who have
their priority permission activated, and have the Supervisor permission. The
start time will be updated as other experiments are entered into the queue. Pri-
ority settings are taken into consideration. Click on the Set Start Time button to
set the time. Using the up/down arrows the date and time may be conveniently
modified. To have the experiment run at the standard time as determined by the
queue logic, just remove the time box with the ‘X’ (delete) button.
Start Times may be copied/iterated to other experiments. IconNMR tries to grab
the time interval from previous experiments and set the times on future experi-
ments accordingly.

17.Time
The experiment time (estimated acquisition time) is calculated each time an
experiment is submitted and also after any parameter editor has been used.

18.User
The user who entered the experiment on the experiment list is denoted in this
column. Note: Experiments belonging to other users may not normally be cop-
ied, deleted or altered in any way. If you want to have complete access to other
users experiments, change user to the nmr super user.

3.4.2 Queue Control buttons

You’ll find an array of queue control buttons in the centre of the Setup Window:

All of the following buttons apply to the selected holder/experiments. Selected
experiments have a light blue background to distinguish them. If only the holder is
selected (no experiment information selected) then the button’s function will be
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carried out on all of the experiments in that holder. Of course you can also mark
particular experiments. 

• Submit <Alt + s>
Submit generates all data necessary for the experiment, calculates the experi-
ment time and sets the status of the experiment to ready. If the run is active the
experiment will be found and executed. Submitting an experiment removes the
editable boxes and substitutes them with fixed text elements which may no
longer be edited. You may only submit an experiment if all the required infor-
mation required to start the experiment is available.

• Cancel <Alt + c>
All of the selected experiments will be effectively removed from the queue.
This button is useful together with the edit button if you want to make changes
to the experiment before run-time. Note you can always re-submit a cancelled
experiment, the information content will not be removed. The experiment is
merely ‘deactivated’.

• Edit <Alt + e>
This button re-inserts the editable boxes on an experiment entry. These may
then be edited in the usual manner. Use in conjunction with the cancel button to
change previously submitted experiments. Click on the edit button again to
remove the edit boxes.

• Delete <Alt + d>
Removes all experiment information from the display and from the queue.
Does not remove any spectral information from the target or archive disk. As
mentioned above to remove all experiments on any sample holder mark the
sample holder the entry where the holder number is indicated. To remove a sin-
gle experiment select that experiment only.

• Add <Alt + a>
To add an experiment to a holder with none (empty tube icon) double click on
the holder or use the Enter key (once the holder is selected). If the holder
already has at least one experiment use the Add button to create more experi-
ments on that holder. The spin box to the right of the Add button determines the
number of experiment lines to be added. These lines will automatically receive
a valid disk, name, experiment number, solvent and title entry. The only infor-
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mation you have to enter is the experiment type.

• Copy
There are several methods of copying a holders experiments to another holder:

a) Sequentially
All experiments on a particular holder are copied to the next (empty) N
holders. This is the default method. Proceed by selecting the holder you
wish to copy. Use the spin widget to the right of the Copy button to set the
required number of copies. All experiments will be copied to the next N
holders in the display area. The expno is incremented to the next free expno
which is a multiple of 10. Should you wish to keep the same experiment
numbers and increment the Name of the experiment; e.g. Jan-19.001, Jan-
19.002 set the Holder->Increment Name menu entry before copying. The
experiment number will, in this case remain constant.

b) Targeted
The selected holder’s experiments are copied to every other selected holder.
This method is automatically selected if more than one holder has been
selected (blue background). The selected holder’s experiments are copied to
all other selected holders. The same numbering strategy is applied as in the
sequential case.

When the copy routine gets to the end of the setup window the copy contin-
ues at the beginning of the table.

c) Multiple Source Holder Copy
You may copy experiments from multiple sequential holders in one single
copy action. Simply select with the control key depressed all the holders you
wish to copy, and finally the target holder. The target holder should not con-
tain any experiments. Then hit/invoke Copy. 

d) Duplicate Experiments on a single Sample. (Experiment Iteration)
Should the same experiments be run multiple times on a single sample the
Iterate menu button may be used to create copies of all experiments which
have already been set up, together with their parameter values and settings.
Click with the right mouse button on a holder or its experiments and choose
Iterate. Use the spin widget to the right of the main Copy button to deter-
mine how often the experiments are to be repeated.
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• Change User

Click on this icon should you wish to login/logoff the system. The login user deter-
mines what experiments and environment the operator will have. You may also
click on this Icon to lock IconNMR. When IconNMR is in the locked mode no
changes may be made to the current setup. It is also impossible to leave the pro-
gram. If you want to alter Experiments entered by other users login as the NMR
super user.

3.4.3 Setup Window Icon Bar

The following icons appear under the menu bar and may be used to access particu-
lar features with the mouse.

The Automation ‘Go’ button

This button is responsible for starting the run. It has the same effect as the 
Run->New Run menu command. Once activated a popup dialog will appear as
shown in Figure 3.2.

The Initialize Run Dialog is displayed each time the run is started, unless the Lab-
oratory manager has configured the system to start the run automatically at start up
time. See “Automation Driver Engine” on page 110.

Figure 3.2 Initialize Run Dialog
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The Acquisition Type field refers to the type of sample changer Driver which is to
be used in the system, BACS/SampleXpress/SampleCase, SampleJet, BEST, Six-
pack, NMR Case, MAS, LCNMR SampleTrack or Manual mode (no sample
changer). These drivers are based on Tcl scripts and may be adapted to suit your
own environment. You’ll find them in:

TOPSPINHOME/prog/tcl/libtix/iconnmr/inmrlib/Automation/driver_lib

Drivers

Driver files have the extension .drv, there’s also a file drivers.tcl which is used to
tie a comment to a particular driver file. This comments appear in the Initialize
Run window.

The First Sample entry tells the system where to start, i.e. which holder will be run
first. With the ‘First sample in the magnet (locked and shimmed)’ it’s possible to
tell the system to skip the locking and shimming routines for the first sample.

As a further option you may instruct IconNMR to skip the processing on all the
experiments it performs. This question may be deactivated from the IconNMR
Configuration window.

The Automation ‘Pause’ button

Use this button to pause the acquisition. This action will take effect after the cur-
rent running experiment has been completed. An additional button will appear to
clarify whether the pause should cause the sample to remain or be removed from
the magnet. If the system is idle the a sample may be removed in this manner.

The Automation ‘Play’ button

As you might expect, the play button sets the Run in motion again.

The Automation ‘Stop’ button

This cancels the current run. It will also stop the currently running experiment. If
you wish to stop the run without interfering with the currently running experiment
use the pause button instead. All experiments which have not yet been completed
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remain in the queue and are still available for running at a later date. The Stop per-
mission is user specific, only the user who started the run or the NMR Super user
(password required) may stop it.

The Sample Holder Overview

Use this button to call up the window shown in Figure 3.3. This window lets you
see at a glance what the sample changer has been up to during the automation. It
shows all sample holders in a grid array. As in the history list if an error occurs on
any sample an ‘x’ appears in that particular holder.

The sample holder overview may also be used to position the setup display at a
particular entry. Just click on the holder you’re interested in. You can even open an
entry on a previously unused holder by double clicking on it. You’ll also notice
that holders in the overview status may be selected in the same way as the holders
in the setup window. Click on the first holder you wish to mark and drag the
mouse. All following sample holders will be selected (marked in blue) in both the
overview and setup window. If you wish to select holders, which are not marked
sequentially (e.g. for a targeted copy), hold down the Ctrl button before clicking on
the particular sample holders.

Acquisition Controls Window

Figure 3.3 Sample Holder Overview 
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This button displays the Automation Control window, provided it has been enabled
in the view menu, and has been enabled in IconNMR Configuration. The button
acts as a toggle. If the window is not viewable it will appear. If the controls win-
dow is on the display, clicking on this will remove it.

3.5 Menu Bar commands

3.5.1 The File Menu

The file menu contains the following items:

• New

You may start a second experiment setup window and setup further experiments to
be run at a later date.

• Open

Open reads in a previously saved experiment setup into the current setup window.
The history information is also loaded.

• Save 

Saves the current state of the Experiment List for Opening at a later date. This will
save a setup file in the directory TOPSPINHOME/prog/curdir/changer/<setup
directory name>.set
IconNMR saves this file automatically for you.

• Save as external setup
This option may be used to generate an external setup file based on the contents
of the setup window. In general this option is not required, it may be perhaps of
interest in cases where barcodes are going to be used.

• Print (List Setup) 
This prints a copy of the Setup file in an easy to read format on the default
printer.
On Windows the notepad program is used to print the file. Use the Edit->Set
Font switch to change the font (if necessary).

• Print History File
Prints the history information at the bottom of the setup window to the default
printer. On Windows you may have to set the default font for the notepad pro-
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gram to obtain reasonable results. Should you have problems the file may be
printed directly from the prog/curdir/changer/inmrchanger directory.

• Close
Closes the setup window.

• Closes all 
Closes all currently open setup windows.

3.5.2 The Run Menu

These menu items may be used in the same manner as those already described in
section 3.4.3.

The following entries are also available:

Manual Lock/Shim
This option may be activated during the run to cause the manual Lock/Shim win-
dow to appear at the appropriate time during the run. Activation is linked to the
User Manager Manual Lock/Shim check button described in section 5.2.1.5

This window, as the name implies, allows the user to lock shim via the bsms key-
board or the bsmsdisp window. When this window appears a timer is started and
automation continues after a time limit of 10 minutes. After the 10 minutes have
elapsed a warning is displayed. The user then has the option of extending the lock/
shim period by a further 10 minutes.

3.5.3 The Holder Menu

Selection Menu buttons

Items in the upper half of the holder menu may be used to quickly select several
items at once. For example you may wish to cancel all successfully completed
experiments in one swoop and then delete them. In this case you’d use the
Holder->Select Completed menu option, followed by the Cancel button and Delete
button.
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Copy Mode

Here you can decide how IconNMR Automation is to copy experiments. Increment
Expno is the default setting and should be optimal for most purposes. Here any
number of experiments will be copied. The system checks and automatically allo-
cates sensible experiment numbers, while keeping the current Name setup.

The ‘Increment Name’ mode keeps the same current experiment numbers while
adding numbered extensions to the name to make new unique data set names.

3.5.4 View and Find menus

These contain various menu buttons which control which elements of the setup
window are to be shown. You may use them to improve the clarity of all display
information. The find pull down helps you quickly find particular types of entries. 

3.5.5 Parameter Menu

As in Routine Spectroscopy mode you can use the parameter menu buttons to
access any of the parameter editors which TOPSPIN has to offer. If the laboratory
manager has configured the operator so that he/she can execute specific com-
mands, e.g. lockdisp then these will also appear in the User Specific Commands
pull-down. See “User Specific Parameters/Commands” on page 100. These but-
tons apply to the entries in the setup window which have been selected. 

Note: Should you accidently hit Edit Parameters when multiple experiment entries
have been selected which you do not wish to edit/view, you may cancel the opera-
tion by hitting the Esc key while the keyboard input focus is in the setup window.

3.5.6 Tools Menu
• Import an Experiment/Data Set

Use this dialog to grab the current data set on display in TopSpin and set it up
for measurement on any particular holder inside IconNMR. This may be done
without the usual intermediate step of updating/creating a parameter set and
setting it up for use within IconNMR via the User Manager. The data set is cop-
ied into the setup window and will be measured with the Solvent, Disk, Data
Set Name and Expno as defined in the dialog window.
Use the ‘Refresh’ button if the data set shown inside TopSpin was updated.



44 Automation
DONE

INDEX

INDEX

After the data set has been imported it may be modified, copied, iterated or pri-
oritized as would normally be done with any standard IconNMR experiment.

• Run an experiment Periodically
Have any experiment repeated automatically any number of times on a particu-
lar holder with a specific time delay between experiments. This window gener-
ates multiple experiments automatically for you. The Start time for the first
experiment plus the delay between experiments may be set inside the Dialog
window which appears.

3.6 SmartDriveNMR

To use SmartDriveNMR click on the Analysis/Verification button at the top of the
Automation window. It will require a suitable license. Default settings on the
desired extent of the verification as well as the maximum time are available. To
turn SmartDriveNMR off for the selected experiment, change the Analysis Type
used. Automatic verification on a selected experiment may be performed with or
without a structure. A suitable CMC_ Parameter set (e.g. CMC_PROTON) should
be used.

For more details see here:
TSHOME\prog\docu\English\topspin\pdf\SmartDriveNMR.pdf

3.7 PotencyMR

To use PotencyMR see the QuickStart guide and PotencyMR manual delivered
with IconNMR.

For support please contact Bruker support desk: nmr-support@bruker.com

3.8 Automation Window Tips

Here are some features of the Automation window which may not otherwise be
apparent.

• Click right on the Experiment Table to Submit, Cancel...etc.
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• To raise TopSpin or the Amix-Viewer (where Available) in any previously mea-
sured data set, double click on the corresponding entry in the history (lower)
part of the setup window

• You can change the width of individual columns in the setup window by drag-
ging the mouse with the left mouse button depressed on any column header
border

• The Delete Key deletes marked experiment setup entries

• The Insert key adds an entry at the anchor position

• The Esc (Escape) Key breaks out of any loop action; e.g. Copying, Submitting,
Deleting or parameter modification of multiple entries

3.9 External Setup

The Automation module of IconNMR may be used in external setup mode. This
means that all the submitted entries are inserted into the setup window for process-
ing without the need for any direct keyboard input to the setup window. 

The entries are created via an ASCII file which must be copied to the 
TOPSPINHOME/prog/tmp directory. IconNMR Automation scans this directory
periodically (every 10 seconds) for new “ext set” files. All you need to do is logon
to the IconNMR Automation software as any valid user. 

This directory should be made writable for all those TOPSPIN users who will be
starting the run/copying the files, if external setup mode is to be used. 

3.9.1 Acquisition parameter setup with extset

Laboratories may employ centralized sample management, which requires that the
experiments to be run are not submitted locally on the NMR spectrometer with
IconNMR, but rather on PCs or a central laboratory computer, from where they
must be transferred into the spectrometer.

The experiments for each sample may be defined in a text file in ASCII format,
e.g. on a remote computer. If IconNMR should execute such an experiment, the
file must be copied into the directory TOPSPINHOME/prog/tmp/ of the spectrom-
eter computer. This default directory may be modified in IconNMR Configuration.

IconNMR periodically (every 10 seconds) checks the directory TOPSPINHOME/
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prog/tmp/ for new ASCII experiment files. Any new file will automatically be
inserted into the desired setup window. The result is the same as if the user had
entered the information directly on the spectrometer.

Once entered into the setup file, the ASCII file is moved from the temporary direc-
tory TOPSPINHOME/prog/tmp/ into TOPSPINHOME/prog/tmp/save. If several
ASCII experiment files are found by extset, they are processed alphabetically
according to their file names.

An experiment is defined by the keywords HOLDER, NAME, EXPNO, SOL-
VENT, PARAMETERS, EXPERIMENT, TITLE. 

The HOLDER line can take the argument/information [AUTOMATIC] instead of
the position the sample should take in the sample changer. The [AUTOMATIC]
setting will cause the entry to be created in the next available position.

They correspond exactly to the fields of the IconNMR setup window. NAME,
EXPNO, and TITLE are optional, i.e. they may be omitted. In that case IconNMR
uses standard default values: EXPNO=10; no title; NAME is formed from the
name of the experiment file, the extension being replaced by the HOLDER num-
ber.

Note:
After the EXPERIMENT keyword only a TITLE keyword may be accepted, any
other keyword will force the experiment to be submitted with the current disk,
name, solvent, user, expno values.

Figure 3.4 illustrates the main Keywords used in ASCII experiment files. Lines
starting with the character # are comment lines, which are ignored. The file con-
sists of a series of keywords (one per line) combined with information. 

When IconNMR sees a new extset file it will read all the information in it and
enter the experiments in the setup and submit them. If you do not wish the created
entries to be submitted then you should include the Keyword NO_SUBMIT in
your extset file before the EXPERIMENT keyword line. With the Keyword
SUBMIT_HOLDER you can submit all experiments for a particular holder at a
later stage. The SUBMIT_HOLDER keyword requires a preceding HOLDER key-
word to be recognized.

There are also keywords DELETE and PRIORITY which may be used to delete all
experiments for a given holder and to set the Priority flag for a given experiment
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respectively.

The new macro PARAMETERS allows for external parameter modification of the
data sets generated for Automation.



The following example ASCII text file summarizes the ext set file features:

# in 1. column means: comment
#The id after the USER Keyword must be active in IconNMR
USER eng
HOLDER 8
# 
NAME June15
EXPNO 10
SOLVENT CDCl3
PARAMETERS ns,1,td,1024
ANALYSIS_PROFILE Method,Sample Weight,105.2,Volume,3.01
EXPERIMENT sw_cosy45
TITLE This is a title\nwith two lines
TITLE This is a second title for the first exp. of the comp.
TITLE This is a third title for the second exp. of the comp.
NAME June16
EXPERIMENT PROTON
TITLE This is a title\nwith two lines
EXPERIMENT C13CPD
TITLE This is a title\nwith three lines\nThird line
#
HOLDER 9
NAME June17
PRIORITY
SOLVENT CDCl3
EXPERIMENT PROTON
TITLE This is a default title
EXPERIMENT C13CPD
TITLE This is a default title
EXPERIMENT C13DEPT45
TITLE This is a default title
#The next two lines delete all experiments for holder 10
HOLDER 10
DELETE
# Only one END statement per complete file !
END
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# Comment line

DELETE deletes all experiments for a holder

END end of holder definitions section

EXPERIMENT experiment name (of type N or C)

EXPNO data set EXPNO parameter (optional)

HOLDER Holder number to be used

BARCODE Tube ID/Matrix ID from a sample

IMPORTED
Indicates that the data set being used already exists and 
should be used as it is

LOCK_PROGRAM Set the Lock program on this experiment

ANALYSIS_PROFILE
Method for AssureNMR, where the method requires 
parameters, they may be included. See example above

METHOD method name (for BEST)

NAME data set NAME parameter (optional)

NIGHT Makes an experiment run in night time

MOLFILE Full path to structure molfile

NO_SUBMIT The entry will not be submitted

PARAMETERS
comma separated list of parameters and their values for 
modification (optional)

PRIORITY enables the priority flag for this experiment

SHIM_PROGRAM Set the Shim program on this experiment

SOLVENT solvent name

START_ANALYSIS

Used to set SmartDriveNMR options:
Use START_ANALYSIS followed by a space and then
SMARTDRIVE,mode,MAXperiment,time,01:00
Other options include FIXperiment and OPTime

START_TIME
Set the start time for this experiment a value (expressed
as nominal seconds from the epoch time of 1 January 
1970, 00:00 UTC)

START_RUN Start the Automation run.

Figure 3.4 Keywords used in Ext Set files
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STOP_RUN Stop the Automation run

SUBMIT_HOLDER
all entries for the defined holder will be submitted, no 
new entries are created

TITLE rest of line is the plot title (optional)

USER data set USER parameter

Figure 3.4 Keywords used in Ext Set files
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3.9.2 Spreadsheet Import

IconNMR also has a facility to load all its experiments from a file which may have
been generated by a spread sheet program, Excel, Open Office, etc. Files may be
imported in .xls/.xlsx or .csv format.

Note:

On Windows systems the “List separator” Regional and Language option decides
whether a comma or for example a semi-colon will be used when generating the
.csv file. IconNMR will monitor this setting and use the list separator as defined by
this system setting. On Linux systems a comma must be used as the list separator
for Icon to handle csv files correctly.

After selecting the file containing the spread sheet information, and selecting the
required sheet, the next step is to define what actually lands in the current setup
window.

3.9.2.1 Comma Separated Value Import Dialog

As may be seen in Figure 3.5, users have access to all the standard settings avail-

Figure 3.5 Spreadsheet Import Dialog
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able in the Setup Window, as well as to the individual columns from the csv file.

3.9.2.2 What information may be extracted

Any single column of information may be used to supply the following informa-
tion:

Disk, Data Set Name, Expno, Solvent, Holder Position, Assure Method, Experi-
ment and a MOL/SD File. 

Parameters may also be modified using the same syntax as in External Setup
(comma separated name value pairs). These values should be enclosed in double
quotes in the spreadsheet. 

E.g. “ns,16” or “ns,16,td,1k”

To extract the information IconNMR either uses the name (1st row) of the data
enclosed in square brackets e.g [NMR_Experiment] or [COL_X] notation, where
X is any column A through Z and following that AA, AB, AC...BA, BB, BC...to
ZZ. As may be seen in the above figure’s “Disk” entry, an item of fixed text may
be combined together with a column to produce the necessary information.

The title may be composed of multiple columns of information. It is imported and
converted into originator items which will then be shown individually should the
title be edited. This originator information will appear in the title according to the
rules governing originator information as defined in IconNMR configuration.
Items which are not recognized as being an originator item will be entered directly
in the title.

3.9.2.3 Assumptions about the .csv file:

The very first row contains the names of the respective columns
The names of the individual columns are thus available to the software and will be
displayed where defined in the orig/title files.

3.9.2.4 Controlling the import process

Experiments are loaded sequentially on a row by row basis from the .csv file. One
row position from the file corresponds to one holder in the setup window. To cir-
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cumvent this and have multiple experiments on one sample, define the holder
information to also be taken from a column in the CSV file.

You may also use a Composite Experiment if the holder position is not to be taken
from the CSV file.

The following items regarding the import may be set at import time:

• Begin at Holder Position
The first holder position to be imported may be specified. The rows from the
.csv file following that will be entered in the following rows of the setup win-
dow. A column from the CSV file may also be used to set the holder entry for
any experiment according to its CSV holder definition.

• Begin at CSV File Row
Normally the import begins immediately following the 1st row of information,
here you may define which row from the csv file is taken first.

• Stop at CSV File Row
In long spreadsheet files use this to determine where the software should stop
importing information. If the value ‘last’ is used, the interface will import the
all the data from the file up to and including the last row.

3.9.2.5 Automatic Spread Sheet import

The .csv/.xls/.xlsx file may also be imported automatically into IconNMR if it is
copied to the external setup directory. In order for this to function correctly it
should first be imported in the standard manner. Once the format of the spread-
sheet has been setup, IconNMR will remember that for future automatic imports
from the External Setup directory.
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3.10 WEB Interface

IconNMR 5.1 contains an embedded web server, meaning that access to all the
automation information including spectral data via pdf files is possible from any
web browser, provided the spectrometer workstation is available on a company
Intranet. If the company firewall is then configured to allow external access from
the Internet, automation control and monitoring will be possible from any internet
access point.

In addition, today’s Smartphone screen format is also supported, so that in theory it
is possible to control the complete automation run and by inference the NMR
Spectrometer from a smartphone/tablet computer. User control is managed in the
same fashion as in the IconNMR Automation interface itself. Multiple users may
of course be simultaneously logged in to IconNMR. All input/output runs over the
main Automation window back at the Spectrometer workstation.

3.10.1 Features:
• Remote Experiment Submission/Cancel/Deletion with full control over:

Title/Originator Items

User Specific Parameters

Priority/Night Settings

Lock/Shim/Automatic Tuning and Matching Options1

Experiment editing now possible

• NMR Administrator may remotely start/stop/pause the automation run

• All Setup and History fields are visible.1

• PDF Representation of plot accessible through History Frame2

• Server may operate in SSL mode. (No eves dropping by third parties)

• Current Status of Instrument depicted by blinking icons

1.  
2.  Must be configured by NMR Administrator
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3.10.2 Configuration

The Web Interface comes disabled out of the box and must be explicitly enabled
via the IconNMR Configuration window. Click on the Automation Configuration-
>WEB Icon Interface page.

3.10.2.1 Enable Web Interface

If this is disabled the web server remains dormant in the current run. The web
server may be enabled or disabled on the fly via the Configuration->File->Update
Run Parameters menu entry.

3.10.2.2 Enable Standard Web Server

The standard http server will be enabled for use. Access it over the URL shown in
“Access Standard Web Server as follows”. This is the address used in your internet
browser. In some instances it may be necessary to us a fully qualified network
address to reach your Automation server. If in doubt contact your IT department.

3.10.2.3 Enable SSL Web Server

Unfortunately due to Export/Import Cryptography restrictions enforced by certain
countries we are no longer in a position to provide the software used to generate
SSL certificates. If you have access to previous IconNMR/TopSpin versions you
may still copy the openssl executable from those versions to TSHOME/prog/bin to
generate/view your own certificate. Besides making your own certificate in this
manner (using the description below) you may also supply your own certificate
generated elsewhere. You may also use a default certificate delivered with the pro-
gram.

By enabling the https server, SSL connections to the IconNMR Web server are
encrypted for security and cannot be easily decoded. This is the standard used for
transactions on the Internet. To use this service you must either supply a server cer-
tificate/key pair which will be used by the IconNMR server, or use the Make Cer-
tificate to generate a self-signed key pair. For use inside a company intranet,
provided SSL is deemed necessary, a self signed certificate should suffice. Once
again contact your IT department if you require assistance/advice. 



56 Automation
DONE

INDEX

INDEX

3.10.2.4 Allow all defined IconNMR Users with standard passwords
via https/SSL server

By enabling this, the https server where enabled will accept the same user names
and passwords as those accepted in the standard IconNMR Automation user inter-
face. The Queue Interaction flag may still be used to prevent any interaction with
the Automation at the spectrometer. If individual users have been defined then the
Queue interaction flag will be taken into account, passwords will be ignored.

Make Certificate

This functionality is discontinued but may still be used in certain circumstances.
See “Enable SSL Web Server” on page 55

The make certificate dialog window grabs information regarding the certificate.
IconNMR generates certificates which are valid for two years. Users accessing the
server will be warned that the certificate is unknown. The certificate may be
installed on the remote computer (where the web browser is running) to circum-
vent this warning. 

Note:
The common name of the certificate should be the name or IP Address of the
workstation controlling the spectrometer. So for example if you use the address 
https://spectworkstation.chem.com/icon to reach the Web server then the common
name which should be entered is spectworkstation.chem.com 
This will ensure that the certificate matches the “site” of the actual web server. The
name on the displayed certificate will also be shown as being valid. That way
when remote users install the certificate they should not be prompted to verify the
certificate again for the life of the certificate. 

The information supplied in the dialog is passed to the openssl program, delivered
with TopSpin which will generate the 2 files in the directory shown below which
represent the certificate key/pair.

3.10.2.5 Using Web Server Certificates from a certification authority

Certificates are stored in IconNMR’s web server program directory, i.e.
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TOPSPINHOME/prog/tcl/libtix/tclhttpd3.5.1/certs

Certificate file name: icon_server.pem
Key file name: icon_server_key.pem

Should you use a certificate/key pair generated by a certificate authority, you will
need to install them in the above directory with the correct file names. 

The certificate/key pair which are generated by the openssl program are generated
with a particular passphrase. Should you use a externally generated keypair you
will have to set their own passphrase in the file

TOPSPINHOME/prog/tcl/libtix/iconnmr/inmrlib/options.iconnmr

Look for the TLS_PASSWORD line, remove the # at the start of the line and
change the “secret” text to your password.

3.10.2.6 Allow all Icon Users

Use this in an environment where you do not wish to use passwords. In this case
entering the username will be sufficient. Users which have been activated in Icon-
NMR will be accepted and logged in without any password being checked.

Figure 3.6 Make Certificate Dialog
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3.10.2.7 Include links for: PDF JCamp-DX Zip

Click these items to include up to 3 links in the desktop mode Web Interface. The
PDF link opens the installed viewer for pdf files, JCamp-DX and Zip options will
allow for downloading the respective data file if the user has such automatically
generated files.

3.10.2.8 Queue Interaction

If Queue Interaction has been disabled, the Submit, Add, Cancel and Delete but-
tons will be missing from the webpage. The history and setup portions of the page
are visible, but no changes in the status of any holders are possible. In the PDA
version the Action button is not available.
The “Queue Interaction Governs” setting may be used to allow all buttons except
Submit. This may be useful where the sample position is remotely reserved at the
spectrometer, the Final Submit always takes place when the sample arrives at the
instrument.

3.10.2.9 Web Users can view Spectra as PDF

This decides whether pdf files automatically generated by the TopSpin plot soft-
ware should be available on the server for download. The “Always” setting implies
that pdf spectral data will always be generated and any ICONweb user may down-
load the pdf spectrum. If the “Only their own Spectra” mode is active then access
will only be granted to the pdfs generated by the users own experiments.

In a running IconNMR, the software will only take notice of a change in the setting
of this configuration option when the Configuration->File->Update Run Parame-
ters.

3.10.2.10 Individual Users/Passwords for Web Access

Define here which users are allowed access to the Automation Server. Only known
IconNMR users may be cleared for web access.

3.10.3 Tips & Tricks

• Firewalls are good
Keep a firewall in place, limiting access to the dedicated IP/Port addresses, or
access the IconNMR web server via VPN. Controlling automation from the



3.11 Selective Experiments inside IconNMR Automation 59
DONE

INDEX

INDEX

beach is nice, but having hackers playing around on the spectrometer is not
what you want!

• Mobile Devices
Customers wishing to reduce the size of the HTML pages being transferred
may switch to the Mobile version of the web pages.
Prefix the /m address to the URL when logging in. (Instead of using http://
Computername:8015 use http://Computername:8015/m)

• Monitoring Web Traffic
The web server provides a /status URL which may be used to monitor network
traffic to the IconNMR server. Log files with the name Icon_Web_log are also
saved in the TopSpinhome/prog/curdir directory and are rotated. 

• Tracking Instrument Processes/Logfiles
Using the url /history it is possible to monitor all important Automation pro-
cesses. The url /file?name=<filename> may be used to grab any file for moni-
toring from the prog/curdir/<user>/ directory.

• Use /info URL for a quick overview of instrument load
Incorporate this in a site showing an overview of multiple instruments.

3.11 Selective Experiments inside IconNMR Automation

IconNMR can run selective experiments based on region files created in previ-
ously acquired data sets. Such selective experiments operate in much the same
manner as a composite experiment, in that they check their reference experiment
for a region file, extract the limits from it and use them for acquisition purposes.
Such selective experiments must contain the word selective in the USERA1
parameter and when, at Submit time, this keyword is seen, IconNMR, will search
for the region file in the reference experiment and enter the region limits in the
SIGF1 and SIGF2 parameters. These values may then be used by the acquisition
AU program for selective excitation. According to how many selective experi-
ments you have in your run on any given sample, each one will get sigf1 and sigf2
set to a different region.

Here is a summary of the steps which are necessary: 

Make a Composite with a preparation experiment and one or more follow-up
selective experiments which reference the preparation experiment
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In the selective experiment set the parameter USERA1 to: selective 
Enter the composite in IconNMR's Automation window. 

Submit the preparatory experiment only. 

When it has run, define the regions (make a reg file) with the regions to selectively
excite. You may then submit multiple selective experiments. (Before the region
file has been created submission is impossible). In each selective experiment Icon-
NMR will set the sigf1 and sigf2 parameters automatically for each of the defined
regions, until no further regions or submitted selective experiments are available.

Your AU program in the selective experiment will have to grab sigf1 and sigf2 and
use them to determine the correct excitation information (pulse length, power,
etc.). 

There are 4 composites delivered with TopSpin which use this system they are:
SELCOGP, SELNOGP, SELMLGP, SELROGP. There the acquisition AU pro-
gram au_sel180zg is used. View this AU for more information.
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3.12 Barcode Operation

Overview
IconNMR 5.1 has the direct capability of running experiments on samples which
are identified by one dimensional or two dimensional (matrix) barcodes. Instead of
selecting a position inside the Automation table which corresponds directly to a
position within the Sample Changer, a barcode identifier (text) is entered either
directly into the table (via keyboard or barcode scanner) or indirectly through a
spreadsheet, external setup text file, Web-Icon dialog, Easy Setup dialog or other
means.

In this mode the experiment table uses an extra column for the barcode informa-
tion to the left of the holder column. The position where the barcoded sample was
found in the sample changer is subsequently shown in the next “holder” column as
soon as the barcode has been found/identified and located. Normally - on start up -
this 2nd “holder” column is empty. 

Submission is only possible after the barcode has been entered.

3.12.1 Barcode Configuration Setup

The barcode operation mode is defined in IconNMR Configuration on the Master-
Switches page. SampleJet and SampleXpress sample changers are supported. To
select the barcode mode of operation, select the “Sample Identification->Deter-
mine Sample Based on” setting to “SampleBarcode/TubeID”. Automation window
tables created after this change will contain an extra column, and IconNMR setup
and history files will contain the additional and searchable barcode information.

3.12.2 Automation Workflow

Barcode operation inside IconNMR automation is straightforward and self explan-
itory. In fact the greatest hurdle you may face when first dealing with barcodes is
getting the barcode label itself. If you are unfamiliar with the wherewithall of han-
dling barcode/cap acquirement, please contact your Bruker sample changer pro-
vider for details on how they may be obtained/generated.

Automation Start

Irrespective of the Sample Changer used, at Automation startup, IconNMR asks
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the hardware regarding the whereabouts of the upcoming barcoded samples. It
does this according to the standard priority rules which are available in the pro-
gram (Priority/NightDay/StartTime). If nothing special is setup the standard
sequential order in IconNMR is used to determine which barcodes are sought first.

SampleJet Systems

When multiple barcoded samples are present and submitted, IconNMR requests
multiple barcodes in a group for measurement.

If the first barcode IconNMR happens to ask for is present and recognized in the
hardware this barcode will “win” and will be measured.

If the first barcoded sample which IconNMR requests is not present but other sam-
ples from the group are, then the identified other samples will win and be returned
for measurement.

If no samples are present in the requested group and the SampleJet determines that
new samples are present and ready for measurement, the SampleJet will search the
positions where it assumes new samples could have arrived at - this searching may
be configured as described below under Configuration Settings.

SampleXpress Systems

Note: If the barcode is numerical, only barcodes with a number > 1000 are
accepted for usage.

The SampleXpress when used together with its cover keeps a record of any new
samples which may have been introduced on the system. Samples with Barcodes
may be inserted to the magnet based on that information. If barcoded samples are
entered in the IconNMR queue which the SampleXpress has not yet seen these will
be sought for measurement. If they are not immediately found, measurement pro-
ceeds with available (already identified) samples.

3.12.3 Configuration Settings

• Allow Combination RackID/Position and MatrixID Barcodes
This flag allows for SampleJet systems to use a mixed setup where samples
with 2D Matrix caps may be used together with barcoded wellplates where the
tubes contained within the plate are not individually identified for measurement
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by matrix id but solely by their position within the barcoded wellplate.

To use this special mode the barcodes for such wellplates must begin with the
character sequence “RJ”. Additionally the position of the sample to be mea-
sured is encoded in the barcode with an appended string of characters denoting
the position within the barcoded wellplate.

So for example here we could use:
RJ2562527.A1 to identify position A1 in the well plate identified by the bar-
code “RJ2562527”

In this mode any samples with their own matrix ids which are individually in
use and submitted will be measured in a strictly first come first served order.
Samples with CombiMatrix/Position IDs may have to wait until such individu-
ally identifiable barcoded samples, which are to run earlier, are found and mea-
sured. Only then will the combination rack/position samples be measured. This
is true even if the combination barcode/position samples are available for mea-
surement.

• Scan Search Priority
Here you may define how the SampleJet goes about searching for missing sam-
ples when IconNMR requests their measurement. Options include:
‘Open Shop Ring’ or ‘Racks’ or ‘Both’. ‘Both’ implies that the Sample Jet will
not pay particular attention to either location.
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Chapter 4

Toolbox Automation Extension

4.1 What is the ICONNMR Toolbox?

Up to now, automation was perhaps only seen as a method of optimizing the
throughput of routine NMR measurements with emphasis on sample turnaround.
But what happens if we're dealing with a small number of samples where an inter-
change of parameter information between multiple experiments plays a pivotal
role. What if we need to deviate from the standard AU macros and parameter sets
without creating a myriad of files which all basically do the same thing? You may
have a picture in your mind about what you want your application to do, but you
neither have the time nor the patience to implement an AU program to do it?

Here's where the IconNMR Toolbox comes in. With this little gadget, operators
can quickly grasp a complex system whereby the nitty-gritty details of how it all
works are neatly tidied up and where necessary concealed. This is indeed possible
without having to adapt standard Bruker AU macros or parameter sets. 
65
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4.1.1 Internal Structure

The ToolBox is essentially a sophisticated and versatile parameter/experiment
browser for the Automation set-up window. Spectrometer Managers running
groups of experiments will find it invaluable in helping them and their not so expe-
rienced colleagues, harness the full power of NMR quickly and easily.

The ToolBox implements a procedure called Dynamic Adaptive Automation
(DAA), whereby each experiment may share relevant parameter information with
other experiments. Each piece of parameter information which is shared, receives
an Import/Export identifier (Name). This identifier describes some experiment
characteristic which may be shared between experiments. 

Experiments which are to actively adapt other experiment outcomes, export their
parameter values to other experiments. Experiments allowing for adaptation must
specify which exported parameters will be imported. The overlying automation
process running inside IconNMR is responsible for the timely transfer of the data
between experiments. Users do not need to use an AU program or other software
to handle the transfer of the parameter value.

The ToolBox browser enables the designer responsible for any experiment defini-
tion, to impart his operational knowledge of the experiment (in the DAA case an
Automation Parameter Set) in such a way that inexperienced NMR users may
instantly discover what parameters are of interest and allows for access to these
parameters. Use the ToolBox browser to define how particular experiment parame-
ters will interact with each other.
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4.2 When should I use the Toolbox?

• For Bio-Nmr Experiments 

• When a group of experiments is routinely run on one or more samples

• When particular parameters are to be set identically on multiple experiments

• When parameter modifications are to be made on standard Parameter sets
depending on the Application 

• To link a particular Shim routine / Shim file or an ATM optimization to an
experiment 

• When experiment dependent default "User Specific Parameter" names and val-
ues (familiar from ICONNMR) are required

• If parameter values which are set by the acquisition/processing are to be
transferred to other experiments automatically 

• If additional/alternative application dependent AU programs are required

• If you have previously been reusing .set files and are continually resetting the
data set names

• For Kinetic Experiments
See the Example Kinetic Experiment Definition accessible under
“File->Import->Load Example Kinetic Experiment Definition”

4.2.1 Fundamental differences to Standard ICONNMR Automation

Users familiar with IconNMR’s Automation interface that may be thinking of
making use of the Toolbox’s features should note the following:

• Currently no support for strict adherence to a tight “Multiple User open access”
structure is provided

4.3 Entering Toolbox Mode

Enter Toolbox mode by clicking on the respective icon of the ICONNMR main
desktop. A identification window will invite you to identify yourself. To return to
the main ICONNMR desktop click on the Exit button of the File menu.

You may also start the program directly via the toolbox TopSpin command.
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4.3.1 User identification

See “User identification” on page 141 for more details on identification require-
ments. At the moment the user identified when entering Toolbox mode has very
little influence on how the program reacts.

4.4 The Toolbox Window layout walk-through

This section provides a general overview of ToolBox features.

After successful user identification, project file selection (File->New Project) and
Sample Addition “Add New Sample” the user interface similar to that shown in
Figure 4.1 will appear on the ICONNMR desktop. 

The toolbox browser is really 2 windows in one. From here it is possible to add
new experiments or groups of experiments to the toolbox, normally though, it will
be used to select, modify and submit experiments to an automation run. Here are
some of its main features:

4.4.1 Upper Control Icons/Status Entries
• Create New Project creates a new project file which will contain all

parameter and, where used, all automation status information. You may leave
your project at any time, and return to the exact same state at a later date.

• Add New Sample
Each project may contain any number of samples. A field will appear asking for
the solvent definition to be set along with the corresponding holder position/
sample number. At this stage, all experiment “Tree” entries are created accord-
ing to the current experiment definition, for the sample.

• Import Experiment Definitions 
Use this to set the current experiment definition which will be used for all fol-
lowing new samples added to the ToolBox. A file selection dialog window will
appear showing any experiment definitions which you may have previously
saved. Experiment Definitions are stored in the TOPSPINHOME/conf/instr/
ICON-ToolBox/Definitions directory. When you remove experiments or add
new ones you are changing the current experiment definition. The ToolBox can
save the current definition for you at any time. It remembers what the current
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definition is, and loads it automatically (provided it has been saved) next time
the program starts.
Note: Experiment Definitions may span single or multiple samples. So if a set
of experiments is routinely used on a set of samples you may save a definition
which will create multiple sample entries at the “Add New Sample” stage. Sim-
ply mark all checkboxes in the “Experiment Types” tree before Exporting the
definition file.

• Import Shared Parameters
Click here to load any import/export variable values from any other project you
may have previously saved.

• Export Experiment Definitions 
Use this to make your own experiment definition file. Mark the holder entry
check box or a group of them. Experiment definitions contain the following
information:

Figure 4.1 ICONNMR Toolbox
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•The complete “Tree” structure of experiments and experiment groups.

•For each group, the contents of the Text window in the right hand pane.
HTML style text may be displayed here if required.

•For each experiment the following information:

1.A user definable experiment name (Independent of the Parameter Set).

2.The name of the parameter set which will be used.

3.A title entry window, which may also contain a default title text.

4.Lock/Shim/ATM settings for this experiment

5.The Automation and Processing commands. (Normally XAUA and
XAUP)

6.A text description of the experiment. The comments from the pulse pro-
gram are appended automatically after any comments added by the user.

7.Parameters, definitions and import export variable names.

• Submit all experiments under selection
This button behaves just like the submit button at the base of the ToolBox.
Select the Sample/Group/Experiment in the tree first to determine what should
be submitted. You can use this feature to submit all experiments in the samples
Tree with one click.

• Cancel all experiments under selection
This is a copy of the cancel button at the base of the ToolBox. 

• Show hide right pane experiment details
Removes the right hand pane of the toolbox window. Behaves in the same man-
ner as the Hide/Show details menu button.

• Drag experiments into current project
Once you have saved your own experiment definitions, you may use this fea-
ture to display them in the right hand pane of the toolbox. Then use the right
mouse button to drag them from the right hand pane into your current experi-
ment tree. Pick and choose any experiment or group of experiments from your
saved experiment definition files and pack them into the current project, or
make a new definition with them.

• Lock/Unlock Toolbox
The toolbox normally starts in a locked state. This implies that changes to the
layout of the experiments and their corresponding parameters may not be made.
To make any changes, click on the padlock and enter the password if required.
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This password check is under the IconNMR configuration window control. It
may be deactivated if required. See the Configuration, General Options page
for details. Alternatively the toolbox may be configured to start in an unlocked
state. See the IconNMR->Configuration->ToolBox Setup page.

• Enable/Disable Live Data Set Generation
The toolbox starts up in “live” data set generation mode. This implies that when
any experiment is clicked on/activated its data set will be created as part of the
project in the appropriate data set directory. This happens irrespective of
whether the data set will be measured or not. Where no data sets are to be gen-
erated, click on the green button which will then change to a red stop sign. In
this mode, no data sets are generated and parameter values will not be updated.
This mode may be used to verify/modify an experiment definition.

4.4.2 Experiment Selection Pane

The left portion of the window allows for the selection of an experiment/data set
for measurement. Experiments are grouped together into Subgroups. Each experi-
ment is in turn linked to a particular data set from the
TOPSPINHOME/exp/stan/nmr/par
directory. At the top of the Tree hierarchy you’ll find the sample name. This is the
name which was entered after clicking on the Add New Sample button. Next to the
Sample Name you’ll find a check box. By clicking on this box you are informing
the toolbox that this sample’s tree should be the default for a possible next sample
which will be added. You will only need to check this box should you make
changes in the current experiment definition. You’ll also find information (in the
2’nd status column) regarding the status of individual experiments (Submitted,
Cancelled, Finished), plus the holder number which will be used. This information
is identical to that shown in the Automation window. 

New experiments or subgroups may be added to the Tree at any point. Experiments
and subgroups may also be deleted at any point.

Clicking on any experiment in the tree creates its data set and sets any parameters
according to the rules defined by its experiment definition. Parameter changes may
be made before the experiment is submitted for measurement.
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4.4.2.1 Experiment Duplication

Normally should multiple instances of the same experiment be required on a regu-
lar basis, then the experiment definition should be modified so that the correct mix
of experiments is contained within the tree. However, a particular experiment may
be duplicated simply by clicking on its tree entry after it has already been submit-
ted. A message box will appear to check whether a duplicate experiment was really
called for. If such a duplicate was created it creates a new additional experiment
entry in the automation page, but the tree itself does not change. The already sub-
mitted entry becomes invisible and only the duplicate remains.

4.4.2.2 Experiment Selection Buttons

The following control buttons are available by clicking with the right mouse but-
ton when over an experiment in the tree:

• Add SubGroup
Creates a new Subgroup after the currently selected location in the Toolbox
Window. An entry box will appear requiring you to enter the SubGroup Name.
After entering a name you may also type in a description of the sub-group in the
“Group Information” window.
You may also enter a filename in the Group Information window - in which
case the file must be in simple HTML format and should reside in the ToolBox
Help/English directory:
TOPSPINHOME/prog/tcl/libtix/iconnmr/inmrlib/lib/BioTool/Help/English
The ToolBox will render the HTML page in the Group Information window in
the next instance of the subgroup.

• Add Experiment
Creates a new experiment entry in the currently selected branch of the experi-
ment tree. The currently selected branch can itself be an experiment although
this is not recommended. After clicking on the button a blank experiment defi-
nition sheet will be shown in the right pane waiting for information. Fill in as
much as possible before proceeding. Should you forget to define import or
export parameters - this can be handled over the “Edit All” button in the right
hand pane.

• Delete Group Experiment
Deletes the currently selected experiment / sub group entry.
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• Submit
Has the same effect as the Submit button in ICONNMR Automation. The cur-
rently selected experiment will be saved on the disk awaiting measurement
under automation control. If a group is selected then all experiments under that
group will be submitted.

• Cancel
Remove the currently selected experiment from the Automation queue. If a
group is selected then all experiments under that group will be cancelled.

• View Data
Saves the parameter data from the currently selected experiment according to
the current import and user configureable settings. Switches TOPSPIN to this
data set and makes the TOPSPIN window appear.

4.4.2.3 “Right Click” Menu

Note that all of the above buttons are accessible directly using your Mouse’s right
button. When you click on your right mouse button, a popup menu window will
appear. The respective action is however always carried out on the currently
selected subgroup or experiment.

• Hide/Show Details
The ICONNMR ToolBox interface requires a significant amount of screen
space. When the parameters have been set up correctly however, it should no
longer be necessary to view parameter values continually. This button may then
be used to temporarily remove the right hand (Experiment Information) pane
from the ToolBox interface. This will be useful in cases where another program
is being obscured by the interface. The pane may be resurrected again at any
time by right clicking on Experiment Selection pane and following up with a
click on the Show Details button.

• Copy
Grabs a copy of the current definition for the experiment under the pointer.

• Cut
Grabs a copy of the current definition for the experiment under the pointer
while also deleting it from the Experiment Types Tree.

• Paste
Inserts the current experiment at the current pointer location.
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4.4.3 Experiment Information Pane

The right pane shows Group/Subgroup and experiment information pertaining to
the selected entry in the Experiment Tree. Here are some of its features:

• Disk, DataSetName Expno

• Name, Parameter Set, Title
The internal Toolbox name for the experiment, the corresponding TopSpin
parameter set, a title line where the corresponding title may be entered. If the
title is set before an experiment tree is exported as an experiment definition,
then the title will be part of the experiment definition and will appear each time
the tree is instantiated.

• Default Parameter Values/Commands (optional)
A space separated list of parameters together with their values to be replaced in
the copy of the standard parameter set being used. This list may also contain
commands which are to be issued during creation of the data set.

An example default list might look something like this:
ns 8 td 8k CMD {XAU my_pulse_determination_au_prog}

This line would ensure that this special au program would be executed after ns
and td were set to the 8 and 8k values. 
The exact order of events is as follows:
RPAR-> Getprosol -> Import Variables are set -> default parameters set/com-
mands executed (according to their order in the list)->User Configureable
Parameter values determined.

You may also pass import/export variable values at this stage and perform
mathematical calculations. e.g.

CMD {XAU my_au_prog $O1($HOLDER)}
would start an au program and pass the contents of the import export variable
O1($HOLDER) to it.

CMD_ONCE is another command macro which as its name suggests will only
be executed once in the lifetime of the data set. 

Arithmetic evaluations|
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Parameters may be automatically set to values which may be the result of
parameter arithmetic run either when the experiment is instantiated or at exper-
iment run time. 

This is achieved by means of the CMD {setpar "parameter name" "parameter
value"} syntax. “Parameter value” may be a mathematical Tcl expression
which works on experiment definition variables 
e.g. [expr {$SWN($HOLDER) / 2}] within the default parameter values com-
mands window. Here’s another trivial example:

CMD {setpar d1 [expr {100 * $D1($HOLDER)}]}

Here the value of d1 would be automatically set to 100 times the value of the
variable D1(HOLDER) before acquisition and on experiment instantiation. Use
the [expr {}] notation to perform the arithmetic.

• Lock / Shim / ATM Settings
Any special case Lock/Shim/Automatic tuning and matching steps required by
the experiment may be entered here.

• Automation Acquisition Commands
Typically XAUA is used here and the AU program as defined by the AUNM
parameter will be used. You may override this and run another au program or
simply zg with the macros XAU my_acq_auprog and ZG respectively. Variable
values may also be passed as shown above in the Default parameter values
commands case.
For Kinetic experiments the macro GOTO_NEXT_SAMPLE is available
which may be used to force the automation to continue with the next available
sample, even if the current sample still has submitted experiments ready to run.
Here the Syntax:
XAUA; GOTO_NEXT_SAMPLE 
is used to perform the acquisition and then continue with the next sample in the
automation run.

• Automation Processing Commands
Typically XAUP is used here and may be circumvented for this experiment as
above. Variable values may also be passed as shown above in the Default
parameter values commands case.
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• Description
A text window used description of the experiment together with the contents of
the experiments pulse-program.

• Experiment WWW Info
A HTML Link to even more experiment related information, describing proce-
dures or parameters. This box will only be shown, if such a link has been
defined. If you want to add a link later use the “Edit All” button to force the
entry to appear. Remember to save a new experiment definition file based on
the sample where you have made the change.

• User Configureable, Import and Export Parameter Panes
Here you’ll find all the parameters pertaining to this experiment. Each group of
parameters is divided into 4 columns: 

1.The internal TopSpin parameter name, e.g. ns (number of scans parame-
ter). This is the same parameter name which you would also type in Top-
Spin in order to see the parameter value.

2.A description the parameter’s role in this experiment. e.g. Number of
acquisition scans. The supplied descriptions in the default experiment are
supplied in English. There is nothing to stop you overwriting them in
another language should that be necessary.

3.The parameter value.
Note that this value may only be taken as being the real value at acquisi-
tion time, provided the acquisition has been started either through Auto-
mation, via the ToolBox’s TopSpin command line or through TopSpin
directly following the activation of the Popup TopSpin button. Changes in
parameter values made in TopSpin will not be updated in the ToolBox
window.

4.Where defined, the name of the import/export variable used for sharing
this parameter’s value between experiments. If you define your own
import/export parameter names, you should attempt to make the names as
descriptive as possible. Here you may add the variable name ($HOLDER)
to the end of a variable. This indicates to the Toolbox that the variable has
been pinned to the current holder (sample position) setting. The current
holder position will be substituted by the toolbox when it sees the
($HOLDER) variable.

The parameters (not their values) shown here are defined in the current experiment
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definition, and may be changed via the edit buttons under each pane. The current
definition file name is displayed in the box at the top of the window. 

Parameter Update Timing:
The User Configureable parameters may be edited at any time and their values will
be reflected in any instance of the experiment run under Automation control.
Should you click on the View Data button, the Import parameters are updated
whenever they change and will also be set accordingly in experiments run under
Automation Control.
Export Parameters are updated automatically under Automation Control after the
processing AU program has completed. The status parameters are used for export-
ing purposes and the Toolbox will grab their values from the status files.

4.4.4 The “TopSpin” command line
Here you may type in any TopSpin command just as you would in TopSpin. 
The entry window has a history feature allowing you to recall old 
commands simply by using the <Up> and <Down> arrow keys. Commands 
are always carried out in the currently selected data set. Typing eda, for 
example will display the Acquisition parameters for the currently selected 
experiment. The parameters are always updated (from the Import List and 
the User Configureable List before the command is executed)

4.5 Menu Bar commands

4.5.1 The File Menu

The file menu contains the following items:

• New Project

The ToolBox always operates on a project file. This project file describes the cur-
rent state of play of the ToolBox window, including the contents of each experi-
ment window which has ever been accessed along with their corresponding
parameters. The project file is also linked to a setup file with the same root name. 

You may use this menu item to open a second ToolBox window at any time. Only
one window may run automation at any one time.

• Open Project
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Open reads in a previously saved project into the current ToolBox window. The
information for the Automation window is also loaded.

• Save Project

Saves the current ToolBox state of play for future re-use. Files are saved with the
extension .tpf and the default directory for .tpf files is 

XWINNMRHOME/conf/instr/ICON-Toolbox/Projects

4.5.1.1 Import

• Import Shared Parameters
Here you may extract the shared parameters from a previously saved project
file. As such it is possible to run a group of experiments based on exactly the
same parameters as a previous group.

• Import Experiment Definitions
Changes the current experiment definition to a previously stored one. Changes
will be reflected next time the Add New Sample button is used.

• Load Standard Bio Experiment Definitions
Overwrite the current default Bio experiment definition with the default one
which is delivered with the program.

• Load Example Organic Experiment Definition
Sets the current definition to a simple Organic one. This is by no means com-
plete but is intended as a staging post for creating more advanced organic
experiment definitions.

• Load Example Kinetic Experiment definition
Here an example Kinetic Experiment definition may be loaded. For more infor-
mation click on the Interleaved Kinetic Experiments Groupname in the experi-
ment types tree.

4.5.1.2 Export

• Export Experiment Definitions
Here you may create your own experiment definition files. The complete struc-
ture and contents of the experiment Information pane are contained within the
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file along with links descriptions, parameter lists and import experiment defini-
tions and references. The actual values of the respective parameters are not con-
tained within the definition.
In order to use this feature - you must first define which sample is to be used for
the definition. With ICON-NMR 3.7 you can make an experiment definition
which covers multiple samples - simply define all samples which are to be
included in the definition before exporting the definition. Note that when you
add a new sample with a definition spanning multiple samples, consecutive
holder positions will be used for all samples. 
Samples are defines by clicking on the checkbox next to the sample name in the
Experiment Types tree.

Definitions are saved in
XWINNMRHOME/conf/instr/ICON-Toolbox/Projects

4.5.2 The Run Menu

For details on these menu items please see the corresponding section in the Auto-
mation manual (see The Run Menu on page 42)

4.5.3 View Menu 
• Automation Window

Displays the Automation window on start-up of the ToolBox interface

• AUNM Args / Default Parameters
This toggles this part of the Experiment Information Window to save space in
cases where it may be unnecessary.

• Parameter Names
This removes the references to the actual data set parameters from the User
Configureable Parameters, Import & Export parameter frames.

• Show Expno, Data Set and Disk information:
Causes the data set name information pertaining to the current experiment defi-
nition to be displayed in the Experiment Information window.

• Popup TOPSPIN in Selected Data Set
This has the same effect as the Popup TOPSPIN button at the base of the Experi-
ment selection pane. It generates the data set where necessary or just updates
the parameters to reflect the current settings.
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4.6 ToolBox Usage/Adaptation

For more detailed information on the standard contents of the Tollbox’s experi-
ment Tree widget along with further information on the experiments which make
up the standard (Bio) experiment Setup - check out the HTML Help area in the
ToolBox window. Detailed description is available there showing the necessary
steps required to measure your first Spectra using the ToolBox.

4.6.1 Adding New HTML style Help System pages

You may add your own Help pages to complement those already included in the
Bio experiment definition program. To do this there are a couple of things to keep
in mind.

1. Simple HTML structures are supported. Any HTML helpfiles you create must
reside in one of the program directories of IconNMR. That directory is as fol-
lows:

XWINNMRHOME/prog/tcl/libtix/iconnmr/inmrlib/lib/BioTool/Help/English

2. As well as this the file Intro1.html (also contained within the above directory)
will have to be changed to include the new file. 

3. Finally you’ll have to type in the name of the html file in the experiment in the
empty Group Information window to link the page with the newly created
HTML file. The contents of the HTML file will be shown next time the current
experiment definition is used.

Note: This current system including the above directory may be subject to change
for future versions of the ToolBox.

4.6.2 How to set the color, bold or italic attributes and 1D, 2D, 3D icons for 
experiment entries in the left pane

This information is only required should you wish to improve the readability of the
Experiment table by adding an icon and changing the color of an experiment entry.
Presently, the ToolBox has only icons available for 1D, 2D and 3D and Watergate-
experiments. To make use of these in an experiment definition the information has
to be included into the experiment name.
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For example if a newly defined Proton experiment is to display the 1D icon and
have the text appear in blue, proceed as follows:

Instead of naming the experiment simply Proton it should be called

{Proton } 1d blue

Note the space after Proton. Should you have a name consisting of spaces this
extra space is not necessary. So for example 

{My Proton Experiment} 1d blue

would work fine. You may use the Rename command to change the names.
The icon and color will be shown in future instances of the definition (not in the
current one).

To make the entry us a bold font the keyword bold is necessary and should follow
the blue keyword. If italic characters are also required then add the italic keyword
at the end.

Here are some more examples:

{My Proton Experiment} 1d blue bold italic
Here the 1d Icon will be shown and the text will appear blue, italicized and bold.

{My Proton Experiment} {} blue {} italic
Here no Icon will be shown and the text will appear blue, italicized but not bold.

4.6.3 Adding your own Icons

If you wish to include your own icons then create the directory:

TOPSPINHOME/conf/instr/ICON-ToolBox/Icons and copy your files into that
directory. Icons may be in gif, ppm or pgm format. Icons which are added in this
fashion will answer to their filename in the toolbox.

Example: Copy the file DOSY.gif to conf/instr/ICON-ToolBox/Icons

Then rename the Dosy experiment in the toolbox to:

{Dosy Experiment} DOSY.gif blue

The DOSY.gif will be used for the Experiment entry.
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4.7 NMR Biotools

The NMR Biotools Window is a new command linked to the IconNMR Toolbox
and accessible via the biotools command at the TopSpin command line. A brief
overview of its features and format is given here.

The Biotools interface is designed to guide you as effortlessly as possible to an
intelligent set of experiments, designed to match your spectroscopic “line of
inquiry”. The program generates a “project” file as mentioned in this chapter,
where all information pertaining to the experiments are kept. However, in contrast
to the Toolbox only a minimum of information is presented to the user and no
changes in the manner in which the Biotools module operates are accessible to the
end-user.

Figure 4.2 NMR Biotools
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The Quick Screen Page provides at a glance access to some of the most powerful
experimental tools available for giving an overview of the sample in as short a
time as possible. These experiments may be run before the long term 3D experi-
ments are employed. Note: Default Parameter Values may be modified to suit the
current project or for all 

Project files with all pertaining information, including the project Automation run
and current state of play regarding completed experiments etc., are available on
disk and may be called up instantly to add further experiments to those already
completed.

Check the online documentation for updates to this NMR Biotools manual. 

Figure 4.3 Toolbox Quick Screen Page
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4.7.1 Modification of the Standard Biotools Interface

NMR Biotools, being embedded into TopSpin’s Automation software benefits
from all the development and fine-tuning which has been invested in the automa-
tion productivity software. And as it is a part of the IconNMR Toolbox, configura-
tion to suit any laboratory environment is simply a matter of adjusting the default
experiment definition files delivered with the program. 

These represent the templates the program uses to know which experiments and
parameters are of interest, which parameters must be shared between data sets and

Figure 4.4 Default Setup Parameters
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whether changes have been made to any of the standard parameter sets.

These files may be found in:

TOPSPINHOME/prog/tcl/libtix/iconnmr/inmrlib/lib/Biotool/Defaults.

To make modifications to the standard Biotools package, start Biotools and click
on the Expert mode button. Then import the correct .edf file from the above direc-
tory corresponding to the group which you wish to change. Make any changes in
the toolbox interface and export the newly adapted definitions to the same name
and directory. Next time the Biotools software is run the changes will come into
effect.
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Chapter 5

Configuration Suite

5.1 Overview

The Configuration Suite (Figure 5.1) is started from the respective icon in the main
mode of IconNMR. You may also use the Configuration Suite menu in Routine
Spectroscopy, Toolbox or Automation modes. This window may only be activated
provided you know the NMR Administration password or if password checking
has been disabled.

Configuration Options

The configuration suite is used to configure all aspects of IconNMR. At the
moment the Configuration Manager is divided into 18 pages: User Manager, Addi-
tional IconNMR Users, Originator Items, Composite Experiments, Automation
Window, Master Switches, Lock/Shim Options, Solvent/Probe Dependencies,
Automatic Tuning/Matching, Priority, Temperature Handling, LC-NMR Options,
SampleTrack Options, Fail Safe /Error Handling, Web Interface, General Options,
Toolbox Setup and the Accounting program

Saving/Loading Multiple Configuration Settings

Although there are very many different configuration settings within IconNMR,
it’s easy to create slightly different Configuration setups for different Autosampler
87



88 Configuration Suite
DONE

INDEX

INDEX

hardware or Automation scenarios. You may save all settings which govern how
Icon will operate internally into a single Configuration File. These may be loaded
back whenever necessary and will set multiple Configuration settings on multiple
Configuration window “Pages” in one swoop. Use the Load and Save menu entries
to save and reload multiple configuration settings. Note that User specific and
other Instrument settings (e.g. Composite Experiments) which are not expected to
change are not saved in such .icf files.

Update Run Parameters

Some configuration settings will not take immediate effect, and this is especially
true for an automation run which is already in progress. Use the menu entry
Update Run Parameters to force the run to reset its internal configuration settings
according to the new settings. For some configuration settings such as the Sample-
Jet driver setting, a new Automation window with the correct sample position for-
mat will only be shown after an Automation re-start.

Figure 5.1 IconNMR Configuration Suite
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5.2 User Settings

5.2.1 User Manager

The User Manager lets you comfortably control just how much freedom the users
of the instrument are going to get. These features apply to both the Automation and
Routine Spectroscopy parts of the program. Setup one template for your users and
save it for all the users on the system. Update the experiments which have been
provided for particular users in one sweep. Save user specific information which
can later be used to group particular users with similar information together. Cus-
tom tailor (for your lab) exactly what information the user must enter before any
experiment may be started (E.g. An Originator ID describing the sample being
measured.) 

The User Names box

When first started the User Manager shows all the workstation user names and
Additional user names which are currently defined for IconNMR in the User
Names box (Figure 5.1, upper left). Additional users (who do not have login per-
missions on the workstation) do not normally need to be defined, they may be
added to IconNMR by using the “The Additional Users page” described on page
102. 

Those users who already have a userfile are shown with a bold font and have an
“enabled” indicator icon.

5.2.1.1 Adding a new user

All items displayed in the various boxes of the User Manager window are valid for
the user/users whose ID is highlighted in the User Names box. Click on the name
whose user information you wish to view or change. The respective information is
then loaded from a file and displayed. When the settings for a particular user have
been updated, save the file using the “Save” button. After this ‘save’ action the
user will have a login account for Automation, the ToolBox and the Routine spec-
troscopy programs.

5.2.1.2 Grouping Users together

In IconNMR, users may be grouped together for improved manageability. Click on
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the Hide/Show Group names icon next to the user list. This will then cause an
additional column with the users group name to appear. Additional input fields
also appear at the bottom of the user list, where a new group name may be added to
all selected users. IconNMR remembers any group names you use to facilitate easy
setting later on. The list of possible group names may be pruned as required via the
“Delete the group from the listbox” icon.

How could using groups make handling multiple users simpler?

You can sort any user list displayed in the user manager by clicking the header of
the list column. Saving/Copying identical values to multiple users who are all
members of the same group is simply a matter of selecting consecutive entries in
the list. When only part of the user settings (e.g. permissions) are to be copied to
multiple users the list of users shown before the copy may also be sorted according
to the group allowing for easy selection of multiple users belonging to a particular
group.

5.2.1.3 The Experiment List box

This listbox is used to define the experiments a user may perform. The list shows
all experiments currently enabled for the user(s) selected in the ‘Users’ box. The
mode and details of the experiment are shown. Mode defines whether the experi-
ment may be run anytime (sun) or only at night (moon). Details comprises two col-
umns show experiment type, and name/comment.

The type is encoded into a single character: N denotes a normal (single) experi-
ment and C a composite experiment. A composite experiment is a sequence of nor-
mal experiments which can be defined in the Composite Experiment Manager. The
member experiments of a sequence may depend on each other. For example, the
first experiment of a sequence could be a preparation experiment for a subsequent
2D experiment. In such cases, the composite experiment manager allows you to
specify the reference experiment(s).

5.2.1.4 Setting up the experiment list

To make any changes in this list you must first activate it by clicking on an entry in
it or by using standard keyboard traversal (tab key) to activate a particular entry.
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The entry box shown in the center of Figure 5.2 will show the type of experiment
you have selected in the list, its name and its comment. Use the following buttons
to alter the list:

• Append
Use this button to add a new experiment below the currently selected experi-
ment. IconNMR can use any of the parameter sets which are known to the TOP-
SPIN rpar command for use inside automation. First select the ‘Source
directory’ to decide which list of experiments is to be used. By default the ‘All
experiments’ source is used, but users may choose to just show the contents of
individual parameter directories (user defined ones) or just the composite
experiments.

Select the name of the new experiment from the field at the right of the Experi-
ment Name entry. This means that you can only add an experiment to a user’s
experiment list if the respective set of acquisition, processing, and plotting
parameters already exists. If you did not set up your own experiments, Bruker’s
standard experiments and standard composite experiments are available, pro-
vided TOPSPIN’s expinstall command was run successfully.
Before you add the experiment to the user’s list, you may change the comment.
The experiment type is a view-only parameter which can take on the values
Single (Normal) (N) or Composite (C). When you add a new parameter set to
the directory TOPSPINHOME/exp/stan/nmr/par/, it will be assigned type N by
default. If the new parameter set designates an experiment requiring prepara-
tion experiments, you must define a composite experiment in Composite Exper-
iment Setup mode, which includes the preparation experiments. You can give

Figure 5.2 Entry Box
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the composite experiment the same name as the parameter set: If a composite
experiment and a parameter set use the same name, the name will only appear
once in the user’s experiment list, and the executed experiment will be the com-
posite experiment.

• Modify
This button allows the information shown in the entry field to be transferred
directly to the currently highlighted line in the list.

• Delete
Remove the selected experiment(s) from the list.

• Update User Files
The contents of the respective listbox (Experiment List, Partition Names, etc.)
may be saved to several user files, leaving all other information in the respec-
tive user files intact. Choose the user files you wish to update from the list
shown as is shown in Figure 5.3.

• Close
This button removes the entry box from the top of the window. The entry box
disappears.

• Apply directly to multiple users
Here you may add/remove the experiment which is currently selected in the
entry box for individual users without affecting any of their other experiments.
So for example you could add a new experiment to multiple users without mak-

Figure 5.3 Update Multiple User Files
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ing any other change to an individual users experiments. In the same way
experiments no longer pertinent may also be removed.

In any of the list windows, use the green arrow icons to change the order of the
entries to suit.

There is also a search button to help find a particular experiment in a long list.

You can also change the order in which the experiments will appear in the user
specific experiment list by using the right-mouse button to move experiment
entries around in the list. First set the focus to the Experiment List (by clicking on
it or using the tab key), that way you can then grab an entry from the bottom of the
list, use the <pg up> key to move the listbox to the top and then release the mouse
button to drop the entry.

5.2.1.5 The User Permissions panel

This panel is located below the User Names box of Figure 5.1 and allows you to
enable or disable certain IconNMR features for a user. 

Priority

A user may declare a sample or experiment to have a priority status. This option is
only meaningful for automation with a “random access” sample changer. The Six-
Pack and NmrCase changers may only operate in a sequential manner and Priority
will be disabled automatically if such sample changers are in use.

Use the Configuration window in the system manager to define how the priority
switch is to be handled.

Archive Data
Use this option to copy all the current experiments data to the Archiving Directory
(also entered from the user manager) after acquisition or processing has been com-
pleted on the current experiment. This feature uses the TOPSPIN wrpa command.
Problems when saving the data are reported in the Remarks section of IconNMR’s
history table. Multiple Directories may be setup and deleted from the list individu-
ally. $USER and $USERGROUP variables may be added to allow for reuse of the
setting in multiple user configurations.



94 Configuration Suite
DONE

INDEX

INDEX

Supervisor
If enabled for a user, the next time this user starts IconNMR all IconNMR win-
dows will get borders and a menu bar, allowing them to be moved or iconified on
the desktop, thus allowing access to other programs without having to terminate
IconNMR. This permission will also gives such users full control over TOPSPIN to
start/stop other processes at will.

Essential Originator
If enabled, the user must enter text into the originator entry before the experiment
may be run. An empty field will not be accepted.s

Manual Lock/Shim
If enabled, the user has permission to override automatic locking and shimming
via the menubutton “Manual Lock/Shim”. The user will be able to lock shim man-
ually. If disabled, the user will not be able to make changes to the current setting.

Parameter Edit
If enabled, the user may invoke the parameter editing commands from the Param-
eter menu in Routine Spectroscopy or Automation modes and alter the acquisition,
processing, or plotting parameters of an experiment before he starts it.

Exit (IconNMR)
If enabled, the user may terminate IconNMR.

Data Set Edit
If enabled, the user may define his own data set filenames. If disabled, he may only
choose from the names provided by the program and set up in the User Manager
Data Set Names box.

Originator
If enabled, the so-called originator information and the associated user specific
information will be included in the filename setup box for Routine Spectroscopy or
in the title window for Automation modes. You set up originator information from
the Configuration->User Settings->Originator Items menu, and user specific
information from the respective box in the User Manager window. See “The Orig-
inator Items Editor” on page 104

Mail Spectrum PS/PDF
IconNMR has a general plot file PS/PDF mailing system available. It may be
enabled under Configuration->Master Switches->Generate Spectrum Print out for
possible e-mail to recipient. This flag enables this feature to be user specific. If
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enabled, the user will receive an email containing a Post Script or PDF file con-
taining the spectrum after acquisition and processing, provided a valid email
address for the user is available. See the note on Data Mail below regarding the
SMTP configuration.

Email Notification
If enabled, the operator will receive an email notifying him of the completion of
his/her experiment provided:

a) Email is operational on the controlling workstation. (A valid smtp
mailserver has been entered on the general options page)

b) The Target Email Address (also available in the User Manager or as an Orig-
inator Item) has been setup correctly for the current user. 

Data Mail
For this option please enter a suitable SMTP mailserver name on the General
Options configuration page. If this is not available or unknown then IconNMR will
attempt to use the TopSpin smail script and the default mailing program to send the
mail. On Linux this is the mutt program which is available on the Linux Installa-
tion CD’s.
This option sends both 1D and 2D data on the Internet to the Target E-mail
Address (if defined). 

Edit Lock/Shim/ATM (Automation Mode Only)
Use this permission flag to decide whether the User should be allowed to change
the default lock/shim/atm settings. When this flag is activated the user will have an
additional menu button, (with a lock signal displayed on it) in the Par column of
the setup window. If multiple experiments have been submitted for a particular
holder position, some of this information may be ignored. For example, if the Shim
setting is to be considered for each individual experiment then the configuration
option “Shim the sample” in the Shimming Controls window should be set to “on
every experiment” 

JDX Copy

It is possible to have IconNMR generate a copy of the data set in JCAMP-DX for-
mat and store the data with an unique name in a directory as specified by the fields
shown under the General Options Tab of IconNMR’s Configuration Suite. This
feature is in addition to all the other Archiving/Data Mail modes.

ZIP Copy
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Works in exactly the same way as the JDX Copy mode described above.

ZIP Data Mail
Work as the Data Mail option, except that the attachment is in the zip format.

Print Spectrum
Sets the checkbutton controlling printing in Automation to on or off. This will then
be the default setting for the user and determines whether a printout is to be made
or not.

Control Printing
Additionally, this flag decides whether a user can modify the default Print Spec-
trum setting above (in Automation). Users having this flag enabled can decide for
themselves for each experiment whether a printout is required or not.

5.2.1.6 The Data Set Names box

Use this box to define the data set names you wish to propose or prescribe for a
particular spectrometer user. All names defined here will appear in the names list
of the Filename box where the user defines the data set name during experiment
set up. If you enable the Data Set Edit checkbutton (see above), the user may also
enter his own data set name. Otherwise he will be restricted to those you set up
here. It is also possible to add a regular expression to govern the text which is to be
allowed. See “The Originator Items Editor” on page 104 for more details on what
can be achieved with regular expressions. IconNMR will see if any of the entered
regular expressions (you can enter more than one) match. If no matching regular
expression can be found the data set name will not be accepted and the text entered
will be shown in red. It is also possible to make a regular expression which will
only match if the input string matches all single expressions coded into it.

IconNMR provides five special names, $DATE, $DATEUSER, $NUMERICDATE,
$USER, $USERGROUP and $HOLDER. These macros will be expanded when the
user opens the names list in Routine Spectroscopy and Automation modes. You can
also make use of date variables such as %M and %Y etc. to form your own stan-
dard data set names. For your convenience these variables are listed here:

%% Insert a %.

%a Abbreviated weekday name (Mon, Tue, etc.). 

%A Full weekday name (Monday, Tuesday, etc.). 
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%b Abbreviated month name (Jan, Feb, etc.). 

%B Full month name. 

%c Locale specific date and time. 

%d Day of month (01 - 31). 

%H Hour in 24-hour format (00 - 23). 

%I Hour in 12-hour format (00 - 12). 

%j Day of year (001 - 366). 

%m Month number (01 - 12). 

%M Minute (00 - 59). 

%p AM/PM indicator. 

%S Seconds (00 - 59). 

%U Week of year (00 - 52), Sunday is the first day of the week. 

%w Weekday number (Sunday = 0). 

%W Week of year (00 - 52), Monday is the first day of the week. 

%V Week of year (01-53), number of the ISO8601 week as a two digit num-
ber (01-53).

%x Locale specific date format. 

%X Locale specific time format. 

%y Year without century (00 - 99). 

%Y Year with century (e.g. 1990) 

%Z Time zone name. 

In addition, the following field descriptors may be supported on some systems
(e.g. Unix but not Windows): 

%D Date as %m/%d/%y. 

%e Day of month (1 - 31), no leading zeros. 
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%h Abbreviated month name. 

%n Insert a newline. 

%t Insert a tab.

Click in the Sample Names box to open the respective edit box at the upper right
corner of the User Manager window. Enter the desired name, $DATE, $NUMER-
ICDATE or $DATEUSER and click on Prepend entry or Append entry to add the
name to the list. Click on Delete entry to remove the currently selected name from
the list. Click on Modify entry to apply changes to the currently selected name.
Update users may be used to save the listbox settings to multiple user files.

5.2.1.7 The Spectrum Number Filename entry

This entry at the bottom of Figure 5.1 provides an additional method of prescribing
data filenames.

The contents of this entry field will be considered as the pathname of a text file
(Example: /usr/adm/spectrumno.txt) set up by the laboratory manager. The file
must hold a name beginning with letters and ending with a number, e.g. H1000 or
C1. This name will appear in the names list of the Filename box where the user
defines the data set name during experiment set up. This particular type of data set
name will automatically be incremented with the next sample. The names in the
above example would then change to H1001 and C2. The incremented name will
be written back to the text file: Should IconNMR be terminated and restarted, the
user would still get the next name in sequence for his new experiment. 

For Automation, when this file has been defined, only the name prescribed in the
file will be available to the user. 

5.2.1.8 Target E-mail Address, Archiving Directory, Umask and Default Portfolio

These three entries allow the above items to be defined on a per user basis, even
for so-called NMR users who do not have a direct login on the workstation. The
archiving directory could be used for example, to define an NFS mounted filesys-
tem which is to be used to store a copy of any experiments data after processing.
The workstation manager is responsible for the setup of such an archiving direc-
tory.
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All data sets generated by the programs have audit trail files which catalog what
has been done on the data set. 

The archive function never overwrites data set directories which already exist on
the target drive. If the Data Set directory with the particular expno already exists,
IconNMR will add a prefix _<Number> to the Data Set Name and try to do the
copy again. It will keep incrementing the <Number> prefix until a free directory is
found.

The Umask entry stems from the Unix world and has some influence over the data
permissions on Windows workstations. In that case, the order of the rw (read, write
flags in as follows. (rw-rw-rw-). The first rw refers to the currently logged in User,
the second refers to the group NmrUser, and the last refer to “Everyone”. It should
be noted that the ownership of the data cannot be “given” to another Windows
user. Ownership on Windows® systems can only ever be taken.

‘Target E-mail address’ is used to define where emails sent automatically from the
specific user account will go. Multiple email addresses may be entered separated
by commas when the SMTP server method is used for sending mails.

Default Portfolio is a SmartDrive feature for general selection of automatically
generated experiments which are to be measured based on that softwares analysis
of the previously measured spectra. See SmartDrive Documentation for details.

5.2.1.9 The Data Directories box

Use this box to define the disk directories where data sets acquired by the current
user will be stored. If you allow for several directories, all names defined here will
appear in the Disk box during experiment set up.

Click in the Data Directories box to open the respective edit box at the upper left
corner of the User Manager window. Enter the desired directory and click on
Append to add the partition to the list. Click on Delete to remove the currently
selected partition from the list. Click on Modify to apply changes to the currently
selected partition. Update user files may be used to save the listbox settings to
multiple user files.

5.2.1.10 The User Specific Originator Info box

Using “The Originator Items Editor” described on page 104, you set up entry items
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which will appear in the Filename box (when using Routine Spectroscopy), or in
the Title window (when using Automation) where the user enters the data set name
for an experiment. The corresponding entry fields (e.g. Department, Costing
Group, or whatever you have defined) will remain empty, and the user must enter a
suitable item, e.g. a department number. In some cases the item to be filled in is
known in advance, and the user should not need to type it in (e.g. his e-mail
address). 

Click in the User Specific Information box to open the respective edit box at the
upper right corner of the User Manager window. Select the desired item (which
you have previously defined via the Originator Item Editor) from the User Infor-
mation Type pull down menu of this box (e.g. the item Mail Data/Noify to). Enter
the respective user data (e.g. the user’s e-mail address) into the User Information
Data entry. If the data changes from experiment to experiment then you should
leave the Originator data field empty. The user can fill it in at experiment set-up
time.

Click on Prepend entry or Append entry to add the information to the list. Click on
Delete entry to remove the currently selected information from the list. Click on
Modify entry to apply changes to the currently selected information. Update users
may be used to save the listbox settings to multiple user files.

Tip - Grouping Users for Accounting Purposes:
Note that you may use this information to group users together for accounting pur-
poses. The Accounting program may search for particular values of originator
entries. If all users belonging to a particular group have the same default originator
item entry, then you may find all experiments performed by such members from
the IconNMR Accounting program. At the Originator field in the Accounting pro-
gram select the correct originator entry and enter the value to search for. 

5.2.1.11 User Specific Parameters/Commands

Here the laboratory manager may define the names of parameters or commands
which the specified user is allowed to change or run. The Parameter Edit permis-
sion does not have to be enabled to allow this type of parameter editing. 

As an example, if the user should only be allowed to alter the TD parameter then
the Parameter Edit checkbutton should be de-activated and the entry td added to
the user specific parameters/commands list. There is also an entry box where
an accompanying parameter description text may be entered. IconNMR will try
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and assign a comment for the parameter name automatically.

Note that TOPSPIN commands may also be entered in this box allowing users with
no “Supervisor” permission to access specific TOPSPIN commands. In Automation,
where possible the command will be run on the appropriate corresponding
acquired data set.

You may configure entries from this list in the same manner as described above for
the Data Directories box.

In Automation mode the parameters are accessed from the Par column button
which is displayed on every active experiment entry line. The Commands may be
accessed from the Parameters pulldown at the top of the setup window.

5.2.1.12 Experiment Quotas

The maximum permissible total experiment duration may be entered for users to
prevent any one user commanding too much time on the instrument. The times
entered are granted to each user per each calendar day. Using the entry ‘Max. Day-
time Experiment Duration’ specifies how long any individual experiment can be
before it is declared too time consuming to run in ‘Day Time’.

5.2.1.13 The Delete, Default, Save, Enable and Disable buttons

The respective commands are also accessible via the File menu. The Save button
saves the current settings on disk, in the file

TOPSPINHOME/conf/instr/<instrument-name>/inmrusers/<userid>

The Default button initializes all boxes with the default information stored in the
file

TOPSPINHOME/exp/stan/nmr/lists/sam_users_exam.inmr

You may save everything you have set up so far for several users at once. Hold
down the <ctrl> key and mark all desired users in the User Names box by clicking
on them. Or keep the <shift> key depressed while clicking on a user. This will
automatically mark all users from the currently selected one to this position. Then
click on the Save button.
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Use the Delete button to remove users from IconNMR. Mark the users you wish to
delete and click on the delete button. Their user file will be deleted.

Use Enable and Disable to temporarily disable access to IconNMR applications for
particular users. To be sure this cannot be circumvented on Windows Systems, the
changes should be made while operating IconNMR as a member of the Nmr Super
User Windows Group. Operators of IconNMR should work as members of the
NmrUser group.

Tip: You may also re-run the processing in IconNMR Automation by submitting
the experiments to be re-run and starting the Automation using the “Processing
Only” Automation driver.

5.2.1.14 Update Experiment List

This new feature arrived in IconNMR 5.1. When a particular user’s configuration
is loaded, Icon checks whether the file has been carried over from a previous ver-
sion of IconNMR. If it has, the small “Open update tool” icon to the left of the
Experiment List will flash. Opening this tool will allow for all new experiments
not currently part of the user’s list to be copied into the current users list - without
removing/altering any of the current experiments. It is possible to choose particu-
lar experiments from all available ones. After the user’s experiment list has been
saved and updated, the icon will no longer flash, but it is still possible to add new
experiments which came with the new version of IconNMR by clicking on the
update icon or “Update Experiment List” button. 

5.2.2 The Additional Users page

Additional Users are Spectrometer Users who do not have a system user account
on the workstation managing the spectrometer. They may, however, still perform
experiments and the experiment information fids etc. will be stored using the NMR
Effective users ID and permission as defined in the User Manager. IconNMRThese
users need not be defined for normal operation.

All Additional Users may have their own password and may initialize or reset it
once they have logged into ICONNMR. 

Additional User names and the respective abbreviations used for their names are
shown in the listbox above the command box. You may modify this list using the
Delete, Append, and Modify buttons shown next to it. The Append entry button
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acts relative to the highlighted position.

The NMR Super User is the name of the privileged user whose password (pro-
vided one exists), must be entered before carrying out potentially sensitive tasks.
This information is defined when TOPSPIN is installed. It should normally not be
necessary to change this. Should you wish to change the NMR Super User then
please use the installnmr script in TOPSPINHOME/prog/bin. See the TopSpin
User Manual for more details on how to use it.

Each Additional User name entered here also appears in the main User Manager
Window User Names list box. User specific information may the be set up there.

5.2.2.1 Externally generated Additional Users

The users and their names are saved in an ASCII Text file in TSHOME/conf/instr/
<spect>/inmrusers/.nmrusers
The format is quite straightforward so the file may be generated externally. Each
user is entered on a separate line in the file with full name, id and password delim-
ited with colons:

Max Musterman:mmu:<Encrypted Password>

or 

Max Musterman:mmu:NULL

if no password was provided.

If the file is to be generated externally a password in plain text form may be pro-
vided. The program then will convert this to an encrypted password when the
Additional Users page is opened for the first time after an IconNMR shut down.
You must then save the configuration to really update the .nmrusers file with the
encrypted passwords. 

If this feature is to be used the user lines in the .nmrusers file should be in the fol-
lowing format.

Full Name:ID:PLAIN_TEXT_PASSWORD:Password

Password is the plain text password requiring encryption

The keyword PLAIN_TEXT_PASSWORD informs the program that what follows
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after the next : is a password in plain text requiring encryption.

5.2.3 The Originator Items Editor

Originator Items are user defined fields which are added to the experiment title.
These Items may be user specific, may contain multiple optional values may be
configured to obey certain rules and users may even be forced to enter some text in
them before an experiment may be accepted.

The Originator Items Configuration Window pane lets you edit the list of items
which may be entered, when an experiment is being setup. Each entry in the list
box created here will appear along with an entry box where the corresponding
information is to be entered (provided the Originator checkbutton for the particu-
lar user has been activated). 

Click on the ‘Add new’ button to add an entry. A combo box will appear where the
name of the Originator Item may be entered. Entries may be swapped or re-ordered
by clicking on one and moving the entry with the mouse up or down.

If a “Regular Expression” is set for the Originator Item then the value of the text
entered in Automation will be tested for conformity to the defined expression.
Here a simple example which may help to start you off.

[A-Z]{2,4}[0-9]{4,5}$

Here only text commencing with between 2 and 4 upper case characters in the
range A-Z and which is followed by between 4 and 5 characters of a numeric type
will be accepted. Any other text outside of these limitations will be rejected at sub-
mit time. The $ at the end of the expression implies that no text which appears fol-
lowing these rules will be accepted. Without the $ sign the rule would allow users
to enter any other text after the required text. If the text entered does not match the
regular expression, then the text will be shown in red.

Use the User Manager window to decide on a per user basis whether the additional
entry boxes will appear at all (Originator Checkbutton) and whether the informa-
tion must be entered before the experiment may be submitted and started (Essen-
tial Originator). Default values on a per user basis may be entered in the user
specific information box in the User Manager.
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5.2.3.1 Useful regular expression examples

Regular expressions can really solve all data management problems caused by
users having the freedom to type whatever they like. Here are a couple of tips for
regular expressions.

a) Disallow whitespace characters (space)
^\S*$

b) How to match only when multiple regular expressions match
For this enclose all regular expressions in (?= ) constructs:
(?=re1)(?=re2)...

5.2.3.2 Automation Mode Options

IconNMR has options to control originator handling more flexibly. 

• Generate orig file in Data Set 
Control whether an “orig” file containing the originator information, will be
saved in the data set.

• Include Originator Item field in orig/title file
Determines whether the Item Names will appear in the title file or Orig file.

• Insert this text between Originator Items
Used to control exactly how the originator information will be formatted. Here
you can separate the items by a newline \n, a tab \t or simply a space.

• Display/Document only those originator items defined for the user
Not all originator items need be displayed. If this switch is activated, then only
the Originator items defined for the current user will be shown. This is espe-
cially useful in connection with the Essential Originator flag as not all users
may be required to set all Originator items.

IconNMR provides a special Originator Item called “Mail Data/Notify to”. This
entry may be used in the Automation mode to override the E-mail address for the
current user as set up in the user manager. This is useful for installations with a
large number of users where only one user configuration is being used.

If an E-mail address is entered here then it will override the User Manager E-mail
address setting for the user. If there is no E-mail address for the current user and no
address has been entered in Automation mode at the respective Title entry field,
then no E-mail will be sent. This way you can decide on a per experiment basis
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when a notification/data e-mail will be sent. Note that the E-mail Notification and
Data Mail notification flags for the particular user determine what type of e-mail
will be sent (if any)

• Standard Originator Values
Consider the case where a single user account in IconNMR is being used for all
measurements eventhough multiple operators are using the instrument. In this
case you may want the name of the Operator to appear on the plot and be stored
in the data set. Defining an originator Item called ‘Operator’ would allow for
each operator to set their name in the corresponding originator field. This
would however prove cumbersome as each user would have to type in their
name every time before submission. They may even make mistakes in typing,
making it difficult to find the data at a later date.

With the ‘Standard Originator Values’ setting, a group of possible values may
be set for each originator item. The list may be read-only or may be set to pick
up and remember new values as IconNMR Automation progresses. The list
may be loaded from a simple text file (one entry per line) via the ‘Load list’
button, or may be added/edited in this window manually. Use the ‘Refresh list’
button to grab any changes which may have come in from the current Automa-
tion setup. 
The entries in the list are shown alphabetically. The last recorded settings are
stored in the file 
TOPSPINHOME/conf/instr/<instrument-name>/inmrusers/.orig_values
If you wish to discard any changes made to the values, close and re-open the
configuration window without saving. These values are also available via the
standard Web Icon interface.

Note:

IconNMR Versions before ICON-NMR 4.1/TopSpin 2.0 used a special file .mailaddr
to record any email addresses which were set via the special ‘Mail Data/Notify to’
Originator Item. These values will be imported automatically into the ‘Standard
Originator Value’ system when IconNMR is first started.

5.3 Composite Experiments

Experiments that may be executed by a user from IconNMR are stored in form of
parameter sets (i.e. acquisition, processing, and plot parameter files) in the direc-
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tory

TOPSPINHOME/exp/stan/nmr/par/.

Bruker experiments are installed in this directory by the expinstall command in
TOPSPIN. The laboratory manager may add new parameter sets. An experiment
name is the name of a parameter set directory, e.g. the COSY experiment would
fetch the required parameters from the parameter files from the directory

TOPSPINHOME/exp/stan/nmr/par/COSY/.

A composite experiment is a sequence of several such experiments. In the compos-
ite experiment manager you define new composite experiments or alter existing
ones. You assign a name to a new composite experiment, and you specify the
names of the experiments that should be included, and the sequence of their execu-
tion. When a spectrometer user selects a composite experiment, all components are
executed automatically. Composite experiments may not include other composite
experiments.

In IconNMR, any experiment requiring preparation experiments must be set up as
a composite experiment. For example, a sweep width optimized Cosy would be
defined as a composite experiment consisting of a suitable 1D, followed by the
actual 2D experiment. A preparation experiment is designated reference experi-
ment within IconNMR.

5.3.1 Defining experiments

In order to define a new or alter an existing composite experiment, click on the
“Add new” button at the base of the manager window.

Apply your changes in the Composite Experiment Editor window shown in Figure
5.4 or enter a new name and a comment. Click on the Modify button to make the
modification effective, or click on Prepend or Append to add the new experiment
to the list.

Click on the Experiment Name button and select the first experiment of the com-
posite experiment and append it using the Append button. Carry on in this way
adding other experiments to the composite experiments. If an experiment you want
to append requires one or two reference experiments, use the F2 Reference and F1
Reference buttons to select them. When you click on these buttons, all experiments
which are already part of the composite experiments will be displayed along with
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their sequence label (a, b, c, ...), and you can choose which ones should serve as
references.

5.3.2 The ‘Save to’ button

After a new composite experiment has been defined you may wish to ‘save’ it to a
particular users user file, thus bypassing the User Manager page.

Mark the composite experiment(s) you wish to save and click on the ‘Save to’ but-
ton. A list of the users who currently have a user file is shown. Mark the particular
users who are to use the newly defined composite experiment and use the ‘Save to
selected users’ button.

The marked composite experiment(s) will be appended to the start of the respec-
tive users experiment list.

5.3.3 The Save, Default, Update buttons

The Save button saves the current settings on disk, in the file:

TOPSPINHOME/conf/instr/<instrument-name>/inmrusers/.pool_txt.

The Default button initializes all boxes with the default information stored in the
file:

TOPSPINHOME/exp/stan/nmr/lists/def_comp_exps.inmr.

The Update button updates the current composite list to include any standard com-
posite experiments which are not in the current list.
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Figure 5.4 Composite Experiment Editor

5.3.4 Defining a Multiple Receive Composite Experiment

From IconNMR 5.1 onwards, multiple receive data sets may be measured in Icon-
NMR Automation simply by selecting a composite experiment. For this to work
correctly make sure the first experiment of any multi-receive sequence is the par-
ent dataset. Make sure its MULEXPNO(0) array parameter is set to -1 in that
parameter set. This will cause the composite to be recognized as a multiple child
parameter sets for the multiple receive data set following the parent should have
MULEXPNO(0) set to 1. F1/F2 referencing settings are not required. You may
mix in standard parameter sets if required.

Multiple receive data sets will appear to be running simultaneously. Processing
will be run sequentially on all parameter sets after acquisition has completed.
Experiment times are only shown for the parent data set.
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5.4 Automation Driver Engine

5.4.1 Master Switches

These options apply to the Automation part of IconNMR only. The “Driver” is
responsible for all spectrometer control commands which IconNMR issues to per-
form experiments. As such it is IconNMR’s engine. 

For more information on drivers see ’Drivers’ on page 39.

5.4.1.1 Run Control

• Default Automation Mode
This is the standard mode of Automation which the program shows when the
run is to be started. For more information on drivers see ’Drivers’ on page 39.

• SampleJet Options
For SampleJet an additional frame appears showing various features pertaining
to such sample changers.
Number of OpenShop Positions
Depending on the type of SampleJet hardware you can set the number of posi-
tions for samples which may be placed in SampleJet’s outer ring.

Rack Sample Sequence
The default sequence of samples the sample changer will follow when working
with racks. The measurement order of sample positions in the setup window
will follow the order defined here. 

Save Sample Data Matrix information to AUTOPOS status parameter
Barcoded samples may have their barcode information stored automatically in
the data set for tracking purposes.

Temperature Conditioning System
Up and coming samples will be preheated ahead of time reducing the equilib-
rium time 

Waste Rack Options
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Open Shop Samples may be sent to waste rack instead of being returned to their
position.

• Eject Last Sample in queue
When this check button has been activated the sample changer will also eject
the last sample which has been measured, after all other submitted samples
have been measured. Some automation modes do this regardless of the setting
e.g. MAS, HRMAS. 

• Never Rotate the Sample
This may be interesting for some users who wish to disable sample rotation
completely without having to edit the acquisition parameters (RO) of all param-
eter sets used in Automation.

• Start run at User Login
Normally the run must be started manually after starting the Automation part of
IconNMR. This means that operators who forget to do this, will submit their
experiments for execution and leave the instrument, to do the work which it
will never see. To get around this potential problem the Run may be started
using this function automatically. When this mode has been activated you must
also define which driver is to be started automatically. Use the Default Automa-
tion Mode to define this.

• Force jump to next sample after every experiment
Instead of Icon running all experiments on a sample before proceeding to the
next one, use this flag to force Icon to only execute one experiment on a sample
and then jump to the next sample. This mode should not be used together with
the new barcode modes of operation.

5.4.1.2 Processing Control

• Generate a Spectrum Printout
Use this feature to suppress the printing normally associated with the execution
of the processing AU program. Processing will proceed as normal but no paper
printout will be generated.

• Wait until processing completed before executing next experiment
Some experiments may depend on processing results from previous experi-
ments. Use this flag to ensure that processing has completed before follow-up
experiments commence.

• Process Data Sets after Acquisition
Possible settings include ‘Always’, ‘Never’ or ‘Ask on Start-up’. When using
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Ask on Start-up a checkbutton will be displayed in the window which appears
after clicking on the ‘Go’ button.

• Generate Spectrum print-out file in data set for possible dispatch to e-mail
recipient
When this option has been activated the processing program will be started
with an additional argument (-e). In this case a postscript or pdf file containing
the contents of the plot will be created in the pdata procno directory. When
IconNMR then sees this file it will pick it up and send it to the currently defined
E-mail address for the user who executed the run. After the postscript file has
been successfully sent the file will be deleted.

Note: If no E-mail address is available the postscript/pdf file will not be
deleted.

This setting is also dependent on the User Manager->Mail Spectrum PDF/PS
permission being activated

5.4.1.3 Data Set Management

• Eliminate ‘data’ and ‘nmr’ from the data set path
Use this feature to change the way IconNMR creates data paths for your data.
With this checkbutton unchecked (default) ICON continues to create data sets in
the old style: /data/<User>/nmr/<Data Set Name>/<Expno>/pdata/<Procno>
Activate the feature and ICON will remove the data and nmr parts of the path.
This feature requires that IconNMR be restarted, no change will occur before
that. This feature requires TopSpin Version 3 or better.

• Eliminate ‘user’ from data set path
Use this in conjunction with the above feature to also remove the user directory.
The same rules apply as in the data and nmr case.

• Ignore the TOPSPIN Prosol Parameters
This is a useful feature which tells IconNMR not to update the parameters
which are usually controlled via the edprosol interface. That way you can be
certain, if you save your parameter set with “wpar ParameterSetName all”, that
you will always be able to reproduce the experiments under exactly the same
conditions.

• Delete temporary Data Sets after experiment end
With this option activated some disk space will be saved during the run. How-
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ever, if you wish to retain modified parameter information in the current setup
(if you plan on running an experiment a second time) it is better to leave this
option off. Otherwise modified parameters may be lost should you wish to
resubmit a completed experiment.

Temporary data sets will be removed by IconNMR on exiting if you do not save
the setup. Icon uses the temporary data sets to store changed parameters, save
time when using the Copy function and for other reasons. The data sets are
stored in
TOPSPINHOME/prog/curdir/changer/inmrchanger/MonthDay-Year-Time-user

The date information is obtained from the system when the setup window is
first opened.

• Allow Overwrite of existing Acquisition Data
This prevents IconNMR from overwriting the nmr data. The check is made at
experiment run time. The program looks for an fid or ser file in the correspond-
ing data directory. Should acquisition data be present at run time the experiment
will be skipped and the remarks column in the history window will indicate that
the data already exist.

5.4.1.4 Lock Shim Options

• Automatic Lock Program

Here you may define exactly what IconNMR’s driver does when trying to lock.
With the Skip option you can tell IconNMR to skip locking altogether e.g. lock
externally from the acquisition AU program, or just run a few samples without the
lock.

The default value for this setting is: 

LOCK #Default

You can enter any TOPSPIN command here, including AU programs macros or
commands you would normally enter on the command line. The CPR_exec_wait
or CPRW macro command tells TOPSPIN to execute the following and wait for the
command to finish. You must always include this to execute your command.

In determining whether the command was successful, the returned string is parsed



when the CPRW macro completes. If the string returned is not NORM_TERM, as
is usually the case if a command fails, then IconNMR will show a failed status.
The XCMD macro is equivalent to the CPRW macro and works exactly as it does
in AU programs. Remember to use ; between commands to run multiple com-
mands at once.

If you want an AU program to be executed and IconNMR to wait until the AU pro-
gram is finished then you should use the XAU macro, instead of the
CPR_exec_wait macro:

XAU <auprogram_name> <arguments>

where auprogram is the name of your AU program and arguments are any optional
arguments you may wish to forward it.

Should you wish the command to be executed in the background (without waiting
for completion) use the command CPR_exec or simply CPR

TopSpin Macros may be started using the XMAC macro:

XMAC <macro_name> arguments

Multiple commands may also be entered, each command should be separated by a
“;”. The “#” signifies that a comment follows.

With TOPSPIN many commands which have to do with TopSpin’s Graphical User
Interface will need to be started via the sendgui macro, so for example to start the
bsms display the text would be:

SENDGUI bsmsdisp

If you need to wait for the TopSpin command to complete use SENDGUI_WAIT

Delays may also be included before or after a command if required. To wait 60
seconds before locking include the following text before the LOCK macro:

after 60000;

You may also use the command aftersec which waits for seconds instead of milli-
seconds:

aftersec 60;

If you’re familiar with Tcl, the tool command language created by Dr. John Ouster-
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hout during his time as Computer Science Professor at the University of Berkeley,
feel free to enter Tcl commands here too.

Delays after command execution

Care should be taken to preserve the return value of the command if a delay is to
be added after its execution. Otherwise ICON will not be able to tell whether the
command completed successfully.

So if a delay is necessary after a command then the command used should take the
following form:

set lock_result [LOCK];aftersec 90;set lock_result

where in this case the locking is done by the LOCK macro and a delay of 90 sec-
onds is to be waited after lock completion.

• Abort Acquisition on Shim Failure
Normally problems on shimming are not regarded as being so serious as to skip
the acquisition. Here you can change this to suit your environment.

• Lock only after a solvent change

Should IconNMR only try to lock when the solvent has changed, activate this flag.
This feature is only available in mode.

• Shimming

IconNMR has lots of features to help you optimize your Automation run to the
limit.

Shimming Controls

• Automatic Shim Program

Use this to decide which type of shimming you’ll be using. IconNMR provides 3
default options:

Default 

TUNESX
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Shim based on the probe/solvent dependent tune file saved when you setup the
system using edprosol TOPSPIN commands.

GRADSHIM

Use the gradient shimming automation program to greatly increase the shimming
performance (you need gradients installed on your spectrometer).

TOPSHIM <args>

Standard gradient shimming based shim optimization routine.

TOPSHIM_WITH_AUTOSHIM <args>

Standard gradient shimming followed by an autoshim on command. Arguments
are passed to the topshim routine.

Skip Shimming

Use this setting when shimming is not required, or where the shim control is han-
dled externally, (e.g. by the Acquisition AU program see the AUNM parameter).

You may of course enter your own command here, any other macros such as the
CPRW macro described above may be used. The XCMD macro is equivalent to
the CPRW macro and works exactly as it does in AU programs. Remember to use ;
between commands to run multiple commands at once.

For simplex shimming (with your own tune file) You could enter a command like: 

TUNE mytunefile

The mytunefile can be generated using the edtune TOPSPIN command. You’ll find
example tune files in: 

TOPSPINHOME/exp/stan/nmr/lists/group

Delays may also be included before or after a command if required. To wait 60
seconds before shimming include the following text before the TUNE/GRAD-
SHIM macro:

aftersec 60;

The argument to the Tcl after command is in milliseconds.

If you’re familiar with Tcl feel free to enter Tcl commands here. Longer Tcl proce-
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dures may reside in the _iconnmrrc.txt file in the startup user’s home directory. 

Be aware that the Driver examines the return string from the macro and should it
be anything other than NORM_TERM, an error will be shown...

Delays after command execution

Care should be taken to preserve the return value of the command if a delay is to
be added after its execution. Otherwise ICON will not be able to tell whether the
command completed successfully.

So if a delay is necessary after a command then the command used should take the
following form:

set shim_result [GRADSHIM_WITH_AUTOSHIM];aftersec 90;set shim_result

where in this case the actual shimming is done by the
GRADSHIM_WITH_AUTOSHIM macro and a delay of 90 seconds is to be
waited after gradshim completion.

• Shim the sample
Specify how intensively the shim routine is to be called.

• Maximum Shim time per iteration
Here you can indirectly specify just how long the shimming part of the automa-
tion will run. This limit applies to each gradient as defined in the tune file. If the
time limit is exceeded on any iteration then that gradient is skipped and the next
gradient started. If the time limit is exceeded at any stage IconNMR will mark
the shimming as failed, but the experiment will still be performed.

• Total Time allocated for tune command (minutes)
To ensure that the length of time taken for shimming remains manageable,
regardless of how many iterations are performed, set this field accordingly. If
TOPSPIN is still shimming after this time has expired the automatic shim routine
will be halted and the experiment acquisition will commence.

Note:

From ICON-NMR 3.1 onwards, you may control exactly what IconNMR does when
it gets to the lock or shim stage in Automation on a per sample basis. For this fea-
ture to work you must first enable the Edit Lock/Shim/ATM permission on a per
user basis (on the User Manager Page). An edit button showing a lock curve will
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be available in the Automation Experiment setup window for each experiment to
be run.

5.4.2 Automatic Shim File Loading

IconNMR has facilities to load a particular standard shim file in Routine Spectros-
copy and Automation modes. The shim files are loaded automatically each time a
new sample has been inserted into the magnet, before the system reaches the lock
stage. That way it is always ensured that the system is in a well defined state for
each new operator/sample. The shim files will be linked to the solvent and the
probe being used.

This window consists of a list of file entries (one for each solvent). The file entries
apply to the probe which is shown in the Current Probe Type box.

Provision is also made to use a particular lock/shim method depending on the
Probe and the solvent in use. When the values are empty the default settings for
Lock Program and Shim Program are used.

5.5 AutoCalibrate

See the dedicated AutoCalibrate Manual delivered with TopSpin.

5.6 Automation Window

5.6.1 Display 
• Holder Status Display Style

Here you’ll find two different status ‘traffic light’ styles, North American and
European, plus a spell-it out text only mode. There is also a Bruker Standard
Style which uses the same color-coding as Bruker’s SampleTrack interface.

• Default Number of Sample Holders
The number of samples to be shown in the experiment manager window can be
set here. 

• Approx. overhead time for sample change (secs)
IconNMR calculates the time required for the acquisition in order to know how
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long the instrument will be busy. With this window you can define just how
much time IconNMR should allow for the sample changing/locking shimming/
automatic tuning and matching etc. when calculating the total busy time.

• Experiment acquisition time calculation
Every time an experiment is submitted the experiment time as calculated by the
TOPSPIN expt command will be shown. This calculation is done once per exper-
iment type and in cases where the parameters have been changed.

• Touch Screen/Large Icons Mode
This check button puts the IconNMR Routine Spectroscopy and Automation
modes programs into Touch Screen mode. All ComboBox style input widgets
switch to a large icon mode which may be easily be accessed on touch screens.
Title/Parameter Input windows get a “virtual keyboard/keypad” eliminating the
need for Keyboard and mouse.

• Show Disk Column for Viewing editing
Here the Disk column may be removed or disabled from the Automation win-
dow.

• Easy Setup (was ‘Form style entry mode’)
This method of submission may be useful when the instrument is working in
environments where access to the instrument needs to be streamlined. Here the
sample position, data set name and experiment number is managed automati-
cally (using either the Spectrum Number Filename or User Manager Data Set
Name entry). All that remains is for the user to set Solvent and Experiment and
Title/Originator Info. In IconNMR 4.5 it’s now possible to use this mode and
still setup multiple experiments per sample. Restart the Automation window for
new “Originator Information” fields to appear. Successfully completed samples
are deleted automatically when free positions are no longer available.

You will find 2 new lists in configuration from ICON-NMR 5 / TOPSPIN 3.5
onwards when Easy Setup mode is enabled. These are normally empty which
implies that the Automation Window, in easy setup mode, will show all avail-
able experiments and solvents. With these lists, it is now possible to setup the
program to show only a simple subset of all available experiments without hav-
ing to manage multiple lists of experiments for multiple users.

The solvent/experiment list in easy setup mode is displayed using a scrolled
window with radio button like buttons for each experiment/solvent. That means
your favorite items at the top of each list are instantly available. You may jump
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through the list anytime to other experiments/solvents by typing the first char-
acter of the desired solvent/experiment. If a default experiment/solvent has
been selected, the list will automatically scroll to show that experiment/solvent.
In the Analysis/Quantification Automation mode, particular experiments will
automatically bubble up to the top of the window (CMC_PROTON).

You may add entries in the experiments list as required to show only a subset of
those available to the currently logged in user. For the solvent list, if any sol-
vents are entered then only those entered will be shown. Use the up down
arrows to set the order of entries as they will appear in Automation. The right
arrow may be used to insert all entries from the solvent list for subsequent
removal of those seldom used.

• Enable Search Window
Disable this checkbutton so that users may not search through Icon’s records of
previous experiments.

• Enable Tools Window
Disable this checkbutton to prohibit use of the “Send to Icon” and “Run peri-
odic experiment” features in the Tools menu.

• Skip Identify User window on Automation start
Use this to have the automation window appear immediately with IconNMR
Automation logged in as the current <system> user.

• Show Sample temperature in Setup Window Status line
Enable this flag to view the sample temperature. This is updated every 30 sec-
onds.

5.6.2 Controls
• Spectral Viewer

IconNMR can use the Amix-Viewer program to view completed spectra. Dou-
ble Clicking on an entry in the history portion of the Automation Window will
cause the configured viewer to appear displaying the particular spectrum. Sub-
sequent double clicks will replace the spectrum with the new one. With the
Amix-Viewer it is possible to load several spectra into the same viewer for
comparison.

• Logout Idle users Automatically
In an open access environment, operators should be required to log themselves
out after they have submitted all their experiments to be run. They may, with
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this option be logged-out automatically after a certain amount of ‘Idle time’ has
elapsed. After this period of inactivity the Identify User window will re-appear
and the experiment manager window will be disabled. It is, however, still possi-
ble to observe what the Instrument is doing. Use the Logout Delay to adjust the
required idle time.

• Enable Automation Controls Window
This flag determines whether a control panel similar to that shown in Figure 6.5
on page 151 will be shown during an automation run. This feature may be dis-
abled to prevent users from (for example) processing the data.

• External Setup Directory
Normally external setup files are picked up in the TOPSPINHOME/prog/tmp
directory. The default setting may be set to another directory via this entry. This
is especially useful if a “pool” directory is to be used where multiple IconNMR
programs scan the same directory looking for an external setup file based on
say a well plate barcode.

5.6.3 Default Solvents and Experiments

• Default Solvents and Experiment
To set the solvent and experiment fields automatically (in cases where they are
rarely changed), enter the settings you require here. Use the blank entries if
IconNMR should not set the solvent and experiment.

5.6.4 HTML Export Files

• HTML History File
IconNMR can save all the information stored in the history list in HTML for-
mat. This entry is used to define where IconNMR saves this file. It’s a good
idea to make sure that everyone can write to this file. If this file is located in a
directory which is supported by a HTML server the History may then be
observed remotely, over the net.

Note the history file is always stored in a plain text format with a .hist extension
with the same name as the setup directory itself i.e. in TOPSPINHOME/prog/
curdir/changer/inmrchanger/<setup directory name>.hist

• HTML Setup File
Here you can define the location of an HTML file which will display the cur-
rent status of the Automation Setup Window in an HTML format. 
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If the paths for both setup and history information are identical, then all informa-
tion will appear in that single file. These settings are now superseded by the Icon-
Web interface. See “WEB Interface” on page 54
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5.7 Virtual Parameter Sets

This section of the configurtion settings deals with a new feature which debuts
with ICON-NMR 5 / TOPSPIN 3.5 and allows for changes to be made to parameter
sets which are used inside IconNMR Automation, before/while they are being used
for measurement. 

Make new or modify experiments for use inside IconNMR Automation based on
any TopSpin parameter set. Click on the boxes to see example settings. Leave cells
blank for default behaviour. Parameters may be modified or easily transferred
between experiments. Alternative/multiple AU programs may be prescribed or
alternative underlying parameter sets specified. Eliminate the need for making new
customized parameter sets (on multiple instruments) containing only minor differ-
ences to standard Bruker delivered ones. All 'Virtual' Parameter Sets defined in the
'Experiment Name' column may be used inside IconNMR Configuration as
required. You may even use the name of an already existing parameter set. In this
manner the parameters of a standard Bruker parameter set may be modified with-
out having to rename the standard parameter set.

Modifications to the Acquisition modus operandi are also possible so that instead
of just executing for example, a single AU program, multiple AU programs or
macros or even just a simple ZG may be issued at experiment acquisition time. All
this will take place, regardless of the setting inside the Parameter set of the AUNM
parameter.

Before Acquisition is performed, a pulsecal AU program could easily be added,
then the optimized parameters recorded, using the saveprofpars AU program, and
these parameters could be easily reloaded on a subsequent experiment via the get-
profpars experiment before acquisition. This can be achieved simply by using the
command sequence 

XAU pulsecal; XAU saveprofpars; XAUA 

on the setup experiment and

XAU getprofpars; XAUA 

on the follow up experiments where necessary. If at any stage of such a multiple
command it fails this will cause the complete command to fail.
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Virtual Parameter Sets can be used to modify how existing TopSpin parameter sets
are used, or to generate completely new experiments based on existing ones which
may be used inside IconNMR without TopSpin having to know about their details.

5.7.1 Settings

Enable Virtual Parameter Sets.
Use this switch to turn the virtual parameter system on or off. When switched off
any user defined parameter sets defined for users in the user manager will no
longer be accessible.

Individual experiment settings

• Enable
Turn individual experiments on and off.

• Experiment Name
The name of the experiment as used inside IconNMR. Choose a new name to
create a new experiment, available only inside IconNMR Automation - or set
the name of an existing parameter set to modify its use when running under
IconNMR Automation.

• Comment
May be used to describe the main principle behind the modification to Icon-
NMR Configurtion users.

• Underlying Parameter Set
The actual parameter set which must be available inside TopSpin and which is
used as a basis for any modifications. This may be exactly the same as the name
given under ‘Experiment Name’ above. This allows for modification of any
standard Parameter sets.

• Command after dataset creation
Immediately after the data set is created this command is issued on the data set.
Typical commands include (see the combobox menu):
SETPAR <parameter> <value> <parameter> <value> ...
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e.g. SETPAR ns 8 td 1k
XAU <au_program>; XAU <au_program>

• Command at Acquisition
Any special commands required at acquisition time may be entered here. Nor-
mally this can take the form of an AU program or you may use other macros
which are already available in other parts of IconNMR configuration. One use-
ful example would be to run the Acquisition with XAUA, then save some
parameter values away using the SAVEPARS macro.

XAUA;SAVEPARS rg o1

This saves the parameters rg and o1 for subsequent use on follow up experiments
on the same sample once acquisition (XAUA) has completed.

To grab the values back into later data sets use the macro GETPARS <list of
parameter values>

GETPARS rg o1; XAUA

Or you could save particular parameter values away for use on multiple experi-
ments.

XAUA;SETVAR RG_VALUE_FOR_MULTIPLE_SAMPLES rg

This runs acquisition then saves the receiver gain value in the parameter <rg> in
the variable RG_VALUE_FOR_MULTIPLE_SAMPLES

To use this anywhere in another data set before acquisition use the setting:

SETPAR rg RG_VALUE_FOR_MULTIPLE_SAMPLES;XAUA

Note the SETPAR and GETPAR macros used here always work on the foreground
parameters (not status) of the data set.

5.7.2 Useful Macros available inside IconNMR Configuration (Virtual 
Parameter sets, Lock Program, Shim Program and elsewhere)
• XAU <au_prog> <args>

Call the au program with arguments and wait for completion.

• LOCK
Perform lock -acqu and wait for completion.
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• TOPSHIM <args>
Perform topshim with arguments and wait for completion.

• TOPSHIM_WITH_AUTOSHIM <args>
Perform topshim with arguments, wait for completion and turn on Autoshim
afterwards.

• TOPSHIM_WITHOUT_ROTATION
Perform topshim with rotation switched off, turn rotation back on after comple-
tion.

• GRADSHIM
Run gradshim in Automation, and wait for completion.

• GRADSHIM_WITH_AUTOSHIM
Run gradshim in Automation, and wait for completion, and turn on Autoshim
afterwards.

• GRADSHIM_WITHOUT_ROTATION
Turn rotation off for the duration of the gradshim routine.

• TUNE <args>
Execute the tune command with timeout times as defined inside IconNMR
Configuration and wait for completion.

• XMAC <args>
Perform TopSpin Macro xmac with arguments and wait for completion.

• DELAY <seconds>
Wait the number of seconds. Seconds can be a floating point number with up to
3 decimal places

• RSH <filename>
Read shimfile <filename> into the shim system

• WSH <filename>
Write shimfile <filename> to disk in the standard directory.

• TESET
Set the temperature in the hardware according to the TE parameter.

• TEREADY <seconds accuracy>
Wait for the temperature currently set in the hardware to be attained with the
given accuracy. Then pause for the time given in seconds for equilibrium to be
attained.
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• ROTATION-OFF
Turn off rotation on the sample. Wait for completion.

• ROTATION-ON
Turn on rotation on the sample. Wait for completion.

• XAUA <args>
Execute the AU program governed by the AUNM parameter, using the xaua
command with arguments <args> and wait for its completion.

• XAUP <args>
Execute the AU program governed by the AUNP parameter, using the xaup
command with arguments <args> and wait for its completion.

• CPR <args>
Execute the TopSpin (cpr), e.g. zg, command as given by the arguments, do not
wait for completion.

• CPRW <args>
Execute the TopSpin (cpr), e.g. zg, command as given by the arguments, wait
for completion.

• RGA
Execute rga and wait for completion.

• ZG
Execute zg and wait for completion.

• LOCK-OFF
Execute lock off command and wait for completion.

• GETPROSOL <args>
Perform TopSpin getprosol command with arguments and wait for completion.

• LCTSHIM <args>
Perform lctshim au program and wait for completion.

• LCGSHIM <args>
Perform lctshim au program and wait for completion.

5.8 Automatic Tuning/Matching 

The latest probes are equipped with tiny motors so that their tuning and matching
characteristics may be varied under software control. The TOPSPIN command atma
tunes and matches the probe automatically according to the nucleus settings in the
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current data set.

The ATM setup page contains the Enable ATM Optimization flag used to globally
enable/disable all ATM activity. It contains a list where matching and tuning may
be enabled and disabled on a per experiment basis. You can either use the copy
button at the bottom right of the page to change elements of the selected experi-
ments, or use the right mouse button when over an entry to get a popup menu
whereby the underlying entry may be set.

Possible settings include “Always”, “Never”, “after a solvent/nucleus change” for
both H and X channels respectively. Nucleus change refers to X-Nuclei. ICON

checks the Nuclei NUC1, NUC2, NUC3 and NUC4 and compares them to the last
time it had X-Nuclei. If there is a difference, an atma command for the X-Channel
will be issued.

IconNMR versions prior to ICON-NMR 5 / TOPSPIN 3.5 had a coarse setting for all
experiments. Now this is an individual setting which may be applied to individual
experiments. If you are upgrading from an earlier version of IconNMR the coarse
setting will be incorporated for all experiments. Also available are settings for
exact, high (start at high frequency and work down) and storeWobb for the wobble
curve.

Note: Users can alter the ATM settings for individual experiments inside Icon-
NMR Automation once they have the “Edit Lock/Shim/ATM” permission set in
the User Manager.

5.9 Priority Options

These options only apply to the Automation part of IconNMR.

•Enable Priority
Here you may globally disable priority handling, including Day/Night
checking altogether. This will speed up IconNMR’s search for the next
sample. If you don’t plan on having priority samples then leave this
option off.

5.9.1 Strategy

These options determine (in general) how priority requests will be handled.
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•Modes accounted for
Determine what levels of Priority you wish to cater for. Options include
Night & Day, Priority Only, Priority and Night & Day.

•Priority Sample Handling
Decide whether IconNMR should jump to a priority sample immediately.
This is a hardware/time unfriendly setting as the sample changer will
move to a priory sample even if more experiments are queued for the
current sample. The default is for the sample holder only to be changed
to the priority sample after all experiments have been completed on the
current holder. This saves unnecessary wear on the sample changer as
well as system overhead (i.e. the uncompleted experiments on the cur-
rently active holder will have to be locked and shimmed again!).

•Use “First come first served” model
Normally, IconNMR looks for submitted samples on the next highest
holder, ignoring the time at which the sample was submitted. It will pro-
ceed to that holder and insert the sample. This saves time and may reduce
wear and tear. This corresponds to the “Never” setting. From IconNMR
3.5 onwards, the mode may be changed, such that the submit time be
taken into account. Samples are then measured, based on the time at
which they were submitted. You’ll also find an “Only at night” option
which should also help in situations where night time experiments were
not being executed, simply because they were at the wrong holder posi-
tion. The First come first served setting is equivalent to the current
“workaround” of setting the priority toggle on all samples before submit-
ting them.

• Randomize Measurement Order
In this mode, the next sample is chosen "at random" from all submitted sam-
ples. When a SampleJet is in use, samples from the same rack are selected, until
all submitted samples in the rack are measured. This mode is useful for mea-
surements of a series of samples, run over a longer period of time, where a
slight gradual change of sample properties should be observed. The random
access prevents any continuous changes in the experimental conditions (for
example a slow deterioration of the shim quality) from overlaying any real
change in chemical composition. In addition the potential aging of samples can
be averaged out.
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• Night Day Switch-over
Set the times used for night-time experiments. You can also specify whether
night time experiments should be allowed to run during idle Day time.

• Night Experiment Duration Limit
Chances are that customers who wish to allow night experiments to run during
idle day time will have certain experiments which are very long which should
really only run at night - and others which are shorter though not short enough
for regular daytime measurement. Here one can determine where the cut off
experiment time should be for a night time experiment such that it be run in idle
day time.

• Determine idle case based on total submitted experiment time per sample.
Normally the decision as to whether a short night time experiment will run dur-
ing day time is based on the experiments own acquisition time. With this setting
short experiments will only run if the summed experiment time of all experi-
ments on the sample does not exceed the Night experiment duration limit. That
way its possible to guarantee that all experiments will run on the sample at once
any one experiment starts.

• During Night Time
Previous to IconNMR 4.5, night experiments simply became visible to the sys-
tem during the night and were unseen during day time. This meant that all
experiments were treated identically during night time. With this setting it is
now possible to increase the priority of day or night experiments during the
night so that the respective experiments run first. Possible settings are ‘Treat all
experiments equally’, ‘Prioritize Day Experiments’, ‘Prioritize Night Experi-
ments’

5.10 LC-NMR Options / Sample Track Options

For further information on these settings see the LC-NMR and Sample Track Man-
uals respectively.

5.11 Temperature Handling

IconNMR has features to set and check the temperature before and after sample
insertion. ICON-NMR 5 / TOPSPIN 3.5 also has a setting to return the temperature to
a specific value when Users can set a fixed temperature for all experiments on the
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sample, or use the temperature setting “according to each experiments TE parame-
ter”. The TESET macro sets the temperature while the TEREADY macro waits
until the required temperature has been attained. 

TEREADY takes two arguments: The first argument defines an equilibrium time
which is inserted after the temperature unit reports that the temperature, with refer-
ence to the tolerance, has been reached. The second parameter determines to what
degree of accuracy the program should require temperature conformance to the
desired value. Where multiple experiments are run on a single sample, the temper-
ature will be updated according to the Post insertion routine. If the temperature is
to be changed between experiments, in cases where the required temperature does
not change the Temperature Set/Check routine will automatically be skipped.

• Idle Time Set/Check
Select this item should the temperature be returned to the defined value after
the final sample has been removed from the magnet. The temperature to be
used as well as the method to attain its setting should may be configured.

• Time controlled temperature handling (SampleCase Sample Changer)
The SampleCase™ sample changer may be used to heat samples before they
are inserted into the magnet. Here you may define how long before the mea-
surement the sample heater for that position should be switched on. The tem-
perature for the sample position is also set according to the experiments TE
parameter at the appropriate time. The temperature setting for the sample posi-
tion is also shown in the Holder column of the experiment setup table.

For VT experiments in Automation it’s a good idea to define TE as a user specific
parameter in the User Manager. That way you can access the TE value quickly
from the experiment definition line. This value (entered in IconNMR) will be
checked when the experiment is submitted. Values above the solvent boiling point
will not be allowed.

5.12 Fail Safe / Error Handling

Fail-Safe Configuration

•Activate Watchdog timer
A watchdog timer has been incorporated into the software which is
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started automatically whenever a spectrometer operation is started on the
instrument. 

•Standard Timeout
The timer is set to a 90 minute interval. If the operation has not
responded after this time, IconNMR will assume the operation will not
complete and the run will be terminated and restarted. Measurement will
pick up where it had left off, so for example, if the acquisition was the
problem, then only the acquisition will be restarted. 

The acquisition time is taken into consideration and the experiment will
only be terminated if the acquisition time plus the Standard Timeout time
has expired.

•Configure TopSpin to respond automatically with “Cancel”...
Software controlling the measurement can, if it has been programmed
without any consideration for Automation, easily ask a question requir-
ing user input before continuing. Such software can then block automa-
tion waiting for an answer for days on end. Activating this feature will
cause the question to be cancelled. The software which issued the ques-
tion will receive an answer equivalent to the User having clicked the
“Cancel” answer.

Error Handling

•Stop the Run on error detection
This feature available only in Automation mode allows for even more
Instrument supervision. If one of the systems being used in Automation
fails completely, for example the lock, then the complete Automation
Run may be stopped automatically. Optionally you may choose to allow
the run to continue (Never) 

•On errors, send notification E-mail to
Enter a valid E-mail address in the space provided, a notification Mail
informing of the error will be sent to the given address. Multiple
addresses may be separated by commas. This feature is especially useful
in BEST mode where invalid results may not necessarily be corrected by
running a second time (insufficient sample).

•Show all warnings in ’Remarks’ field
For any procedures started by IconNMR, message window information
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showing in TopSpin will also appear in the remarks window of the Pre-
ceding experiments list.
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5.13 Options

This section of IconNMR Configuration is divided up into two separate pages:
General and “Resource File Settings”. The latter refers to hidden items of configu-
ration which up to ICON-NMR 5 / TOPSPIN 3.5 could only be configured using spe-
cial _iconnmrrc file residing in the user directory. See below for more details.

5.13.1 General

Archiving

•Archiving Copy User (Unix only)
If root access on the workstation is allowed, directories will be generated
where needed. If you use the normal user action, IconNMR may not be
able to copy the data if the directory structure does not already exist.

Title

•Include Originator Information in Title
Normally the originator information will be stored in the title file. Use
this option to disable this feature. Originator Info will in any case be
stored in the data set, in the file “orig”. For more information on Origi-
nator Entries See “The Originator Items Editor” on page 104.

•Include Experiment/Sample Information in Title
Here a range of information will be copied automatically into the title.
Items copied include the holder position and experiment name. The Rack
label and type will also be copied automatically.

•Take initial title from parameter set
Titles saved in the parameter set being used will be loaded into the Auto-
mationWindow title automatically. Users may change the title as is nec-
essary.

DataSet

•Modify data set permissions after processing
IconNMR always acquires on a data set which has ownership according
to the currently logged on Workstation user. After processing has com-
pleted however, the permissions and ownership will be changed accord-
ing to the user who submitted the experiment and the Umask setting in
the User Manager. You may turn this feature off by disabling this entry
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•Remove existing ACLs (Access Control Lists)
Only available on Windows systems, this flag affects how IconNMR
deals with file/directory permissions which are normally inherited from
parent directories. Normally (Default setting) those inherited permissions
are simply removed, leaving only the User, Group (NMRUser) and
Everyone settings. If turned off, permissions inherited from parent direc-
tories are no longer removed. The standard IconNMR groups are added
to the existing Access Control Lists.

•Experiment Number Automatic Increment
Normally a space of 10 experiment numbers will be left for additional
experiments on any given sample. Use this dialog to change this.

Security

•Check Passwords
For those of you working in a trustworthy environment, use this menu to
slacken the password checking mechanism in IconNMR. You may dis-
able checking altogether, or reduce password checking to Manager Items
and start-up with the ‘Sensitive Tasks Only’ option.

•Show users in login Window
Normally, when logging into IconNMR Automation, a list of all avail-
able users on the instrument is displayed. To prevent this, un check this
box. User’s will then be required to enter both user id and password
before logging into IconNMR.

•Passwords cannot be empty
Prevents accounts without passwords from being allowed

•Use Bruker Users
Allows for the display of users generated under TopSpin control using
the Keycloak system to be displayed in the User Manager and used
throughout IconNMR. In order for IconNMR to be able to discover all
such users, credentials and server addresses/port will need to be setup.
Normally IP is localhost and Port 8443 is used. 
Restart IconNMR completely after making any changes to these settings.

Display

•.Font Size Adjuster
Here you make limited adjustments to the font size used in all IconNMR
programs. Changes will be made after a restart of the program.
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TopSpin

•Display all TOPSPIN Warnings
Here you may instruct TOPSPIN not to display any dialog windows of
type “Seen”. The information will however still be reported in the TOP-
SPIN history file.

Mail

•SMTP Mail Server
This is typically the IP name of the server where mails coming from
IconNMR are typically sent. Authentication is supported. The mail
address used here should not be a personal mail account but one which is
instrument/lab related. The password is encrypted and hidden by the pro-
gram, but users who are entitled to work with IconNMR configuration
are still allowed to view the password by editing the entry. Thus a per-
sonal password is not recommended if multiple users use IconNMR Con-
figuration.

If no server name is set then the program will attempt to use mailing cli-
ent programs which may or may not be present.

•“From:” Address
To circumvent problems with SMTP servers which reject virtual names
such as “Bruker Spectrometer AVIII 600”, enter a real existing e-mail
address here. This will appear as the From address in any mails which
are sent from the spectrometer.

•Security Type:
Choose TLS/SSL when encryption is to be used

•Port
This information is available from your IT department

•User Name
As required by the SMTP server. If this and the password field is left
blank then no Authentication will be used

•Password
As required by the SMTP server. If this and the User Name field is left
blank then no Authentication will be used. This entry is protected by
“dots” so that the entry may not be casually seen. Previous settings may
however still be seen if the entry is edited and then the Eye icon clicked
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on. For this reason a mail account which is not a personal one and is
accessible to all persons configuring IconNMR should be used.

•Send Mail in HTML
Use this to send Mails in HTML format instead of plain text. A default
Bruker logo and separator image is embedded in the mail. IconNMR will
try and use image files in the Home Directory of the user starting Top-
Spin to allow for flexibility on this point.
The files it looks for are: 
IconNMR-Mail-Logo.png and 
IconNMR-Mail-Separator.png respectively. 
Start IconNMR with the argument ‘info’ from TopSpin to find out what
the correct home directory is.

JDX Copy Mode 
IconNMR will generate JCAMP-DX files automatically at the end of the measure-
ment/processing and copy them to the directory which may be entered here. 

•Include these data types
Decide whether to have the fid, spectral data or both data types included
in the JCamp file.

•JDX Compression Mode
Define the compression mode to be used here

•File naming format
It is also possible to define which filename will be used for the file. Click
on the pulldown menu to see some examples. The Keywords
$DATASETNAME, $EXPNO, $USER and $USERGROUP are avail-
able together with $RACKTYPE, $RACKLABEL and $HOLDER.
USERGROUP is the group name as specified in the IconNMR User
Manager. The first three variables are available in both Routine Spectros-
copy and Automation modes. Any other text which should appear in the
filename and does not change can also be entered here.

If processing has been disabled, then only the fid may be converted. All
other modes will be ignored. Both 1D and 2D data formats are catered
for by the tojdx command.

The directory used may contain the $USER and/or $USERGROUP vari-
ables to make the target directory user specific. USERGROUP is the
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group name as specified in the IconNMR User Manager.

See the tojdx command in the TOPSPIN Users Guide for more information.

5.13.2 Resource File Settings

See see ’Other Useful features configurable via Options->Resource File Settings’
on page 20

5.14 Analysis/Quantification

Structure Verification (the check as to whether a structure given as a .mol file is
consistent with one or more spectra) can be activated in the tile CMC-Verification.
The configuration tile/page is divided into three sections:

1.SmartDriveNMR

2.PotencyMR

3.General Options

4. Experiment Tracking

5.14.1 SmartDriveNMR

SmartDriveNMR is intended to streamline the structure verification task. With
intuitive NMR-independent inputs from the user, the software is able to carry out
the structure verification independently. It will determine the appropriate experi-
ments to measure with optimized acquisition parameters (e.g. NS) and perform an
automated analysis within the time allotted for the sample. The workflow starts by
default with the acquisition of the Parameter set CMC_PROTON (a quick 1D
experiment on 1H without solvent suppression). The following experimental route
depends on the verification results with the given structure and this 1H spectrum.

To activate SmartDriveNMR for each experiment holder, tick the box next the
SmartDriveNMR. Below that, one can set some default values which will be used
as a starting point for each holder/sample.

Depending on the number of stars chosen with the Desired Confidence level and
the more time is set, the higher the chance that an advanced NMR experiment like
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e.g. an HSQC will be performed.

For more details see here:
TSHOME\prog\docu\English\topspin\pdf\SmartDriveNMR.pdf

Quantification of a dataset requires a reference spectrum of a molecule with known
concentration. The data path to this reference spectrum has be specified in order to
calculate the concentration of the compound of interest. If this field is left blank,
the structure verification will be performed without a quantification analysis. Set-
ting can be done by selecting a Path to the quantification reference spectrum.
This reference spectrum needs to have at least one marked region in the spectrum
annotated with the amount of contributing H atoms as well as the concentration in
mM. This annotation can be done within CMC-assist or TopSpin via eretic2.

5.14.2 PotencyMR

5.14.3 General Options

The settings given here apply to both - SmartDriveNMR and PotencyMR and
CMCq.

Directory to search for mol files

Useful feature which will cause IconNMR to look for mol files with the same data
set name in the directory given here. If a mol file with the same name is discovered
it will be copied automatically into the data set at run time.

5.14.4 Experiment Tracking

Lists of the measured experiments can be generated according to the chosen group-
ing options. These lists (also called serial processing lists) can be displayed in
CMC-assist as a batch.

5.15 File Menu Functions

File->Load

All the options apart from those stored in the ‘User Manager’, ‘Composite Experi-
ments’, ‘Additional Users’, ‘Originator Items’ and ‘Web Interface’ may be saved
into files for simple future changes. For example if one spectrometer setup
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required use of gradient shimming together with particular temperature handling
option and another setup never requires temperature options you may switch back
and forth easily by saving both configuration setups using the File->Save and the
switching between them using the File->Load menu entry.

• Load
Here you may reload previously saved configuration settings, so-called .icf
files made with previous versions of IconNMR. These files do not store all of
the configuration, please use the Import/Export Configuration menu entries.

• Save
Any changes made in the configuration window including possible changes in
User Settings windows (User Manager, Composite Experiments, Additional
Users and Originator Items) are written to their respective files.

• Restore defaults
Sets all options apart from the 4 above mentioned pages back to their original
settings. 

• Import Configuration
Using an .xml file previously saved with “Export Configuration” below, decide
on a page by page basis, which items of configuration are to be set as was saved
in the .xml file being imported. For example you can import just the User Set-
tings for a particular user(s) plus the Composite Experiment definitions. Leave
the configuration on one spectrometer as it is, but set the “Virtual Parameter
sets” to be the same as used on another spectrometer. All particular items
(Pages) of configuration may be selected individually for import.

• Export Configuration
Save the complete IconNMR configuration to a single Extensible Markup Lan-
guage (XML) file. Parts of the same or the complete configuration may be thus
transferred to other instruments using IconNMR. Chose between exporting the
complete configuration or only parts of it - which may make importing the con-
figuration easier at other instruments.

• Update Run Parameters
Activating this command forces an already active run to reset the “Driver
Engine” parameters which normally are only read once (at the beginning of the
run). Parameters which obviously have nothing to do with the run, for example
User Manager settings will not be updated.

The changes will be made after the current action has completed. So if for
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example, the default locking procedure is to lock automatically using the
LOCK macro, and the instrument is currently locking then the change will
come into effect next time the system reaches the lock stage.
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Chapter 6

Routine Spectroscopy

6.1 Entering Routine Spectroscopy mode

You enter Routine Spectroscopy mode by clicking on the respective icon of the
ICONNMR main desktop. A flashing icon will invite you to identify yourself. To
exit click on the Exit button of the File menu.

6.2 User identification

6.2.1 Identify yourself

When you click on the identify user icon, a dialog box (Figure 6.1) is opened
which displays a list of possible spectrometer users. Select your user id from the
list either with a single mouse click, followed by a click on the OK button, or dou-
ble click on your ID. The program will then request your password. If your ID
does not appear in the list, use the User Manager, accessible form the Configura-
tion Menu to create a userfile for yourself. 

User ID’s and passwords

The user identification dialog box similar to that shown in Figure 6.1, will contain
141



142 Routine Spectroscopy
DONE

INDEX

INDEX

the ID’s of all users which have both an account on this workstation and a user file
defined using ICONNMR’s User Manager window. In addition, the box includes
the ID’s of so-called NMR users. NMR users need not have their own workstation
account. Instead, they are defined by the laboratory manager on the Additional
Users page of Configuration where they are assigned an ID and, if desired, their
own password.

In other words, legal workstation users may enter Routine Spectroscopy mode, as
well as other people to whom the administrator wishes to grant access to the spec-
trometer by adding them to the NMR users list.

An NMR user who does not have a password must use the effective NMR user’s
password. This is a legal workstation user on the workstation who was defined to
be the effective NMR user by the laboratory manager on the Additional Users page
of the ICONNMR Configuration window.

Figure 6.1 User identification
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The user ID selected to get into Routine Spectroscopy mode has a direct influence
on the ownership of the acquired data. If your ID is a legal login ID, the data will
get read/write access permissions for yourself and all members of the Unix group
you belong to. You may alter this using the Umask setting in the User Manager. If
you are an “NMR user”, the data access permissions are those of the effective
NMR user.

6.3 The Routine Spectroscopy desktop

6.3.1 The flow chart

If your identification was successful, the window of Figure 6.2 will appear on the

Figure 6.2 Routine Spectroscopy Flow chart
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ICONNMR desktop containing icons that are arranged as a flow chart in order to
guide you in the appropriate way through the set up steps required before the
experiment can be started. As you can see from the flow chart, there are only a few
operations to perform: Inserting the sample into the magnet, defining a file name,
defining the solvent, and defining the experiment. Then you are ready to click on
the start button to execute the experiment. Before that, you may at any time repeat
a set up step to apply any corrections.

The flow chart can be displayed in two modes by clicking the Status toggle button.
The second shows a status panel appended to the chart which allows you to view
the parameters defining the current experiment. If any parameter remains unde-
fined (except for the title parameter), you cannot start the experiment. Please note
that within the status panel no parameters modifications are possible.

6.3.2 The File menu

This menu contains the Exit command to terminate the Routine Spectroscopy desk-
top. After successful log in the Exit to Iconnmr button may be used to leave the
routine mode without returning to the identify user stage.

6.3.3 The Options menu

This menu contains the following commands:

• Manual Locking and Shimming
If the check button Manual Lock/Shim is activated, the acquisition software will
neither lock the field nor shim automatically. These tasks are left to the user: As
soon as the procedures are required after starting the experiment, a dialog box
will invite the user to execute them manually. Manual locking and shimming
require a permission to be set in User Manager mode.

• Change password (only available for NMR users)
This command allows the current ICONNMR user to change his password.

6.3.4 The Configuration Menu

This menu contains the following commands:

• CONFIGURATION

Use this to define global features of ICONNMR, like the shimming method to be
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used before Acquisition, or the default increment to use for the experiment
numbers. See “Configuration Suite” on page 87. for more details.

6.4 The Inject/Eject icon

Figure 6.3 (left side) shows the window which appears when you click on the
Inject/Eject Sample icon. 

The window has 2 different modes of operation Manual and Sample Changer
operation. To use the sample changer mode the unit must have been configured
using the cf TOPSPIN command.

The manual mode consists of a command sequence panel, and a command panel
with a flashing frame, inviting you to select a command. Choose either Exit to
close the window, or Insert Sample to turn on the sample lift. A sample residing in
the magnet will be lifted, and a dialog box will ask you to insert a new sample. The
command sequence panel monitors the actions of the spectrometer during this pro-
cedure.

After the experiment has been successfully completed the Inject/Eject window will
also contain the buttons Eject + Terminate, Use Same/Continue and Insert New
Sample. The Eject + Terminate button ejects the sample from the magnet, and sub-
sequently terminates the current ICONNMR routine session. Use Same/Continue
increments the experiment number by one leaving the sample in the magnet, while
the Insert New Sample starts the change sample procedure.

6.5 The Filename icon

6.5.1 Selecting the data set name

When you have inserted a sample in the magnet, you must define a data set name
for the fid and spectrum to be acquired. The dialog box of Figure 6.3 (right side)
will be opened as soon as you click on the Filename icon. The data set filename
follows the conventions of TOPSPIN, where an fid is stored in the directory

/DU/data/USER/nmr/NAME/EXPNO/

The corresponding spectrum is stored in
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/DU/data/USER/nmr/NAME/EXPNO/pdata/PROCNO/

DU is the disk unit or partition where the data will be stored. If for a particular user
only a single partition is provided in the User Manager mode, DU will not appear
in the Filename selection box. Otherwise a user may select the desired DU from a
list.

USER is the identification code a user typed in to enter Routine Spectroscopy
mode. It not only defines the location of the data on disk, but also the access rights
for the data (cf. section  for details).

NAME is a string to identify the data files of a particular sample. A user enters the
desired name into the respective text entry field, or selects the name from a given
list by clicking on the Names button right of the entry field. The list is defined for
each user in the User Manager mode. In this mode, the Data Set Edit checkbutton
can be set, so that a user can only use the names on the list, but not enter his own
particular name. Furthermore, a Spectrum Number file may be set up which auto-
matically assigns a system wide, unique name for each sample used (see Section
4.8).

EXPNO is a number with the default value 10. The purpose of EXPNO is that a
user may keep the same NAME for several experiments, but differentiate the data
by another EXPNO. We recommend you increment EXPNO by 10 to prevent a
conflict with the EXPNO counting used in composite experiments. A composite
experiment actually performs several experiments, e.g. a 1D preparation experi-
ment followed by a 2D. ICONNMR will increment EXPNO by 1 in these cases.

PROCNO is a number with the default value 1. It need not be changed in Routine
Spectroscopy mode.

6.5.2 The originator information

Several other items may appear in the Filename selection box, such as the Depart-
ment or the E-mail address in Figure 6.3. This so-called originator information can
be configured in User Manager mode by invoking the Originator Items Editor.
The originator information, if present, will automatically be appended to the plot
title. See “The Originator Items Editor” on page 104..

6.5.3 Command buttons

The Filename box provides the following command buttons:
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• OK
Accept all changes and return to the Routine Spectroscopy flow chart.

• Cancel
Discard all changes and return to the Routine Spectroscopy flow chart.

• Continue
Accept all changes and carry on with the next item of the Routine Spectroscopy
flow chart, i.e. open the Solvent selection box.

6.6 The Solvent icon

6.6.1 Selecting the solvent

The Solvent and Experiment selection box (Figure 6.4) is shown when you click on

Figure 6.3 Inject/Eject and Filename dialog boxes
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the Solvent icon or on the Continue button in the Filename selection box. Choose
the solvent for your sample.

The solvent list displayed is the list setup by the laboratory manager with the com-
mand edsolv during TOPSPIN configuration.

6.6.2 Command buttons

The Solvent box provides the following command buttons:

• OK
Accept the selected solvent and return to the Routine Spectroscopy flow chart.

• Cancel
Discard the selected solvent and return to the Routine Spectroscopy flow chart.

Figure 6.4 Solvent and Experiment selection window



6.7 The Experiment icon 149
DONE

INDEX

INDEX

• Continue
Accept the selected solvent and carry on with the next item of the Routine Spec-
troscopy flow chart, i.e. open the Experiment selection box.

6.7 The Experiment icon

6.7.1 Selecting the experiment

The Experiment selection box (Figure 6.4, right side) is shown when you click on
the Experiment icon or on the Continue button in the Solvent selection box. Choose
the desired experiment for your sample.

The experiment list displayed is user dependent and setup by the laboratory man-
ager in User Manager mode. See “The Experiment List box” on page 90..

6.7.2 What is an experiment?

Each experiment name in the list is associated with a set of acquisition, processing,
and plotting parameters stored in the directory

TOPSPINHOME/exp/stan/nmr/par/<experiment name>/

Bruker provides a pool of the most important experiments with its software,
installed at TOPSPIN configuration time with the command expinstall. The labora-
tory manager may define additional experiments using the TOPSPIN eda, edp, edg,
rpar, wpar commands.

Some experiments are denoted as composite experiments defined in the Composite
Experiment Setup mode of ICONNMR. A composite experiment is a sequence of
normal experiments which you define in Set Composite Experiment mode. The
member experiments of a sequence may depend on each other. For example, the
first experiment of a sequence could be a preparation experiment for a subsequent
2D experiment. In such cases, the composite experiment manager allows the labo-
ratory manager to specify the reference experiment(s).

When an experiment is started, a sequence of preparation steps for data acquisition
are executed, followed by the acquisition of the fid(s), followed by data processing
and plotting. The preparation steps select the preamplifier, adjust the lock, the
shims, and the receiver gain, controlled by the Tcl script
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TOPSPINHOME/prog/tcl/xwish3_scripts/inmr_scripts/qnmr_sx_tcl

The actual data acquisition is performed by the AU program AUNM which an
acquisition parameter defined in the experiment. AUNM may be modified by
using the eda parameter editor before experiment start.

For processing (Fourier transform, phasing, integration) and plotting, the tcl script
calls the AU program AUNMP, which is a processing parameter of the experiment.
The AUNMP parameter may be modified with the edp parameter editor.

6.7.3 Command buttons

The Experiment box provides the following command buttons:

• OK
Accept the selected experiment and return to the Routine Spectroscopy flow
chart.

• Cancel
Discard the selected experiment and return to the Routine Spectroscopy flow
chart.

• Set Plot Title
A text entry window is opened where you can type in one or several lines which
will become the title of the spectrum plot. The title window will already contain
the originator information if defined. When you terminate the window by click-
ing on its OK button, the title text will be saved in the following file where it is
looked up by the plot software:

/DU/data/USER/nmr/NAME/EXPNO/pdata/PROCNO/title

6.7.4 Modifying parameters

After an experiment has been defined, its acquisition, processing, and plotting
parameters are initialized from the standard parameters for this experiment. Using
the commands of the Parameters menu, the parameters can be changed before the
Start icon is activated. The standard parameters sets will not be affected. Parameter
modification requires the governing permission checkbutton to be set in User
Manager mode.
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6.8 The Start icon

Once everything is setup correctly, i.e. the sample is in the magnet, file name, sol-
vent, experiment, and plot title are defined, the traffic light in the START icon will
turn green and you may the activate the Start icon to launch the experiment. 

6.8.1 The acquisition in progress window

After starting the experiment, the flow chart will be overlayed by the acquisition in
progress window (Figure 6.5) containing the file name and EXPNO, the remaining

time the experiment needs to finish, the experiment name and its comment line.
The figure shows EXPNO=31, which in this case indicates, that a composite
experiment is in progress: The 1D reference experiment had EXPNO=30.

Figure 6.5 Acquisition in progress window 
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The window provides the following command buttons:

• FID
Displays the fid being acquired in real time. 

• Spectrum
Displays the spectrum being acquired in real time.

• Lock 
Displays the lock signal in real time.

• Halt
Halts data acquisition when the current fid is complete and stores it on disk for
further processing using the Plot button.

• Plot
Processes the fid stored on disk when Halt was pressed and plots the spectrum.
In fact, the AUNMP AU program is called for this purpose. If processing has
already been carried out, this button merely plots the spectrum afresh.

• Exit
Returns to the flow chart. This button is not active while the experiment is in
progress.

• Stop
Stops all spectrometer activity immediately. No valid data will be available
afterwards.

• Search
After an experiment has been completed this button may be used to look at pre-
viously acquired spectra.

6.8.2 The acquisition status icons

These icons allow you to observe the current experiment status. Whenever the pro-
gram begins to execute a particular procedure, the corresponding status icon will

Initialize Lock Shim Gain Acquire Process

Figure 6.6 Acquisition status icons
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blink until the task has been completed. When processing is finished, the exit but-
ton will be enabled. Using this button will return control to the flow chart for set-
ting up the next sample.

6.8.3 The accounting file

Every experiment started in ICONNMR will generate an entry in the accounting file

/TOPSPINHOME/conf/instr/<spectrometer>/inmrusers/Inmracct.brief and

/TOPSPINHOME/conf/instr/<spectrometer>/inmrusers/Inmracct.full

The .brief files contain only essential information and are shorter.

Table 6.1 shows the initial section of such a .full file which reports the spectrome-
ter users and the experiments they performed, including the time and disk space
requirements. The file will grow with time, and it is the responsibility of the labo-
ratory manager to archive and delete it periodically. Such accounting files are the
basis for the accounting manager provided by ICONNMR which generates an
invoice for any user, user group etc. based on unit prices per hour of spectrometer
time and Megabyte of disk usage.
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--------------------------------------------
----  IconNmr Accounting File

----
----  Created Tue Jan 23 12:31:50 MEZ 1996

--------------------------------------------
#Login

name: mg1
host: bigi

group: user 20
date: 01/23/96 12:32 822396721

--------------------------------------------
#Spectrometer: DPX250

--------------------------------------------
#Experiment

nameOfExperiment: PROTONNREXP
solvent: Acetic

fileName: Mark2076 40 1 u mg1
fileSizeAcq: 32768
fileSizeProc: 16384

NUCLEUS: 1H
INSTRUM: DPX250

timeOfStart: 01/23/96 12:32 822396744
timeOfTermination: 01/23/96 12:33 822396824

#User Specific Info
Email Address: mg@bruker.de

---------------------------------------------
#Logout

date: 01/23/96 12:33 822396838
--------------------------------------------

Table 6.1  Section of an accounting file
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Accounting 

7.1 Introduction

The accounting software is started from the Configuration window. It gathers the
information required to calculate prices for spectrometer usage from an accounting
file. The structure of an accounting file has already been discussed in the Routine
Spectroscopy section of this manual. Each time an experiment is executed under
control of IconNMR, the standard accounting file:

TOPSPINHOME/conf/instr/<instrument name>/inmrusers/Inmracct.brief

is updated.

At start up time the accounting program collects and sorts all user information
stored in this file. Depending on its size (which can grow significantly during e.g. a
month’s period), you may have to wait some time until the dialog box similar to
the one shown in Figure 7.1 appears.
155



156 Accounting
DONE

INDEX

INDEX

7.2 The File menu

The following commands are available:

Select accounting file
By default, Inmracct.brief is the standard file responsible for all accounting infor-
mation. However, the accounting information search can also be performed on
other files with the extension .brief. The open command will display all files of
this type stored in the directory TOPSPINHOME/conf/instr/<instrument name>/
inmrusers/. Select the one you wish to use for accounting. Its name will be dis-
played in the header bar of the dialog box. After you have chosen a new file the
accounting information is collected and sorted. This process may take some time,
so please be patient. A Remove feature is available to delete older accounting
information in a particular time frame to speed up the calculation process.

Figure 7.1 Accounting configuration
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7.3 The Report menu

The following commands are available:

Display on screen
Re-display the report generated via the Start button.

Print
Print the report generated via the Start button on the current printer.

Save as
Store the report generated via the Start button in the specified file. If the file 
name does not begin with a “/“ character, the report will be stored in the login 
user’s home directory.

7.4 The Accounting for box

In this box, you enter the users or the department etc. for which you want to gener-
ate an accounting report. The accounting mode is also selectable.

• Enabling the User button will instruct the accounting software to generate a
report for the user which you may select from a list. Click on the down arrow
button to the right of the User button to display the list. This list is determined
at startup time from the standard accounting file, or from the file you have cho-
sen via the Open command in the File menu. The special list entry All will com-
pile a report for all users present in the list.

• The Group button is similar to the previous User item, however, accounting is
performed for the specified Unix group. The special list entry All will compile a
report for all groups present in the list.

• Enabling the Originator button provides the most flexible accounting method
in the per Experiment mode. Click on the down arrow button to get the list of
originator items displayed that you have set up with the Originator Items Edi-
tor, and select one of them (e.g. Department). Enter the suitable accounting cri-
terion into the field to the right of it (e.g. a department identifier). 

You may also search using wildcards the following wildcards are available:

•* Matches any sequence of characters in string, including a null string. 

•? Matches any single character in string. 
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•[chars] Matches any character in the set given by chars. If a sequence of
the form x-y appears in chars, then any character between x and y, inclu-
sive, will match. 

•\x Matches the single character x. This provides a way of avoiding
the special interpretation of the characters *?[]\ in pattern.

Example 1:
Assume you have selected the accounting type Department. The item Department
is member of the list because you have defined it as originator item with the Origi-
nator Items Editor. Assume further that in your organization departments are iden-
tified by numbers. In order to generate the accounting report for the department
8009, enter this number as the accounting criterion. As a result you will get the
total sum of spectrometer usage for all users belonging to this department.

Example 2:
Assume you have selected the accounting type E-mail Address. The item E-mail
Address is member of the list because you have defined it as originator item with
the Originator Items Editor. Assume further your E-mail addresses have the gen-
eral form user@organisation.country. In order to generate the accounting report
for all users belonging to organization, enter the text @organization as the
accounting criterion. Accounting would then be performed for all users of organi-
zation, also for different country extensions.

This example indicates that the accounting program applies a slightly different
identification method to alphanumeric text as compared to plain numbers: In the
first case substring matching is employed, while numerical must be matched
exactly.

• Setting the per Experiment mode will instruct the accounting software to
account the time between the start and end of an experiment.
Setting the mode per Login will instruct the accounting software to compute the
accounting information based on the time between Login and Logout.

7.5 The Accounting Period and Unit Prices 

Please fill in the date of the first and last day of the accounting period (the
sequence is month, day, year). If you want to charge night time rates specify the
start and end time. Otherwise set the time of night start and end to 0, in this case



7.5 The Accounting Period and Unit Prices 159
DONE

INDEX

INDEX

the accounting program requires less calculation time. Then fill in unit prices that
you intend to charge to the spectrometer users: A unit price per hour of spectrome-
ter usage and a unit price per megabyte disk storage consumed during the account-
ing period. The total is calculated according to

number of hours of spectrometer usage (day) * unit price per hour (day) +
number of hours of spectrometer usage (night) * unit price per hour (night)
+
number of Megabytes consumed * unit price per MByte

If you don’t want to charge for the disk space, set the unit price per MByte to 0.

You can also enter a currency. The program will append it to all prices printed in
the report. It does not perform any currency calculations with it. You can select the
currency from a list. If you don’t find that of your country, you may add it to the
file

TOPSPINHOME/prog/curdir/<user>/.currency

Next time you enter the accounting software, your own currency will be included
in the list. You may also delete unwanted items from this file.

7.5.1 List the Experiments

Includes the names of experiments which were run in the report

7.5.2 List Originator Items

Use this switch to generate a list of times and costs associated with a particular
user which is broken down into respective Originator Item values. This is possible
by first selecting the User “All”, then select Originator and chose a suitable Origi-
nator and a wildcard (e.g. *). The wildcard in the value box beside the Originator
Item tells the Accounting program to search for all appropriate Originator values.

Using this feature it is possible to generate a user specific list which is broken
down into the different originator values used by the user when submitting experi-
ments.

7.5.3 Show Report as

Use this setting to generate reports in the old style or in .csv format which may be
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imported easily into spreadsheet programs.

7.6 The Start button

The program will start accounting according to the parameters you have defined
during the previous steps, and display the report. Figure 7.2 shows a typical report
including the performed experiments. The number close to each experiment name
indicates the number of times this type of experiment was executed during the
accounting period. The report also lists incomplete experiments which have been
started but were interrupted either by the operator or because of an error situation.
Failed experiments are not included in the price calculation. 

Accounting File: /usr/adm/Inmracct.brief
Accounting mode: per Login

User: guest
Accounting Period:  from 01/01/10 to 01/31/10

Spectrometer time (day): 5 h 15 min
Spectrometer time (night): 0 h 31 min

Disk Space total: 2.81543 MByte
Unit Price per hour (day): 25 US$
Unit Price per hour (night): 10 US$

Night time:  from 17:00 to 7:00
Unit Price per 1 MByte disk space: 10 US$

Number of experiments: 51
List of experiments:

7 x PROTON
11 x PROTON128
5 x PROTONEXP

28 x PROTONNREXP
Please note: Incomplete experiments:

2 x PROTON

Item price time: 131.35 US$
Item price disk: 28.15 US$
Total price:  159.50 US$

Figure 7.2 Accounting report example
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